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Proprietary Rights and Disclaimer
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1. INTRODUCTION

TAMARIN, the Toolbox of Applied Metrics and Analysis of Regional Incentives, is a planning
support system developed to assist in regional conservation planning. It is a customized
ArcView project with scripts originally written specifically for the Central Atlantic Forest Corridor
project in Bahia, Brazil. The tool was designed to test various strategies and assumptions about
future land use against a set of descriptors of forest landscape configuration believed adequate
to meet biodiversity conservation objectives. The toolbox is NOT intended as a stand-alone
decision-making device or to usurp the role of policy makers. The initial development of the
toolbox was conducted by researchers at the University of California, Santa Barbara, under a
grant from the World Bank and completed in early 2002. Since then, TAMARIN has been
further enhanced and developed by Conservation International and The World Bank, such that it
is now easy to adapt the system for use in emerging corridors worldwide. This document is a
manual to instruct users in the functioning and operation of TAMARIN to create and evaluate
conservation strategies using example data from Bahia. If not specifically stated it should be
assumed that the descriptions of methods and examples in this manual refer to the particular
case study of the Central Atlantic Forest Corridor in Southern Bahia.

TAMARIN performs two sets of GIS-based procedures. Firstly, it assists planning teams to
design scenarios, and secondly, it evaluates the economic and ecological consequences of
these scenarios. Scenarios can be created by drawing on an electronic map or by defining
rules for selection based on conservation and/or economic criteria. Scenarios can be
constrained by a maximum budget limit. The framework can then calculate the ecological
effects and costs of the scenario and create a series of GIS themes, tables, graphics, and
reports that summarize the salient features for comparison with the current situation, projected
future conditions, and other scenarios.

This manual is intended to be a complete user’s guide to the toolbox, but assumes the reader is
already familiar with ArcView and Microsoft Windows. To make the manual easier to follow,
program names are always shown in bold font and pre-defined input and output file names are
in bold Italics. Menus and their options are listed in 'single quotes’. Pre-defined program
variables and parameters are generally underlined.

Before describing the software and its use, here are definitions of key terms that are used
throughout the manual:

e bioregion—a subdivision of the planning region or corridor that distinguishes distinct
biological composition. In south Bahia, bioregions were delineated by vegetation formations
(east to west) and assemblages of endemic flora and fauna (north to south). Section 3.4
describes this GIS theme in more detail. Representation goals (see below) are set for each
bioregion.

e business-as-usual scenario—a future land use/cover pattern that is expected from current
trends if no conservation intervention occurs. One such scenario for Bahia is provided with
TAMARIN (Section 3.2), but the system allows users to substitute their own projections.

e caatinga—savana-like open canopy xerophytic deciduous vegetation growing in western part of
Bahia.



cabruca—a traditional system of growing cocoa under the shade of native overstory trees in
Bahia, often with intervening patches of primary forest, and therefore considered important
for the preservation of flagship primate species in the corridor (Alger and Caldas 1994).

core forest—mature or restored forest (see below) that is beyond the influence of edge
effects and thus provides habitat for forest interior-dwelling species.

corridor—a planning region comprising a mosaic of land uses, including a network of parks,
reserves and other areas of less intensive use whose management is integrated to ensure
the survival of the largest possible spectrum of species unique to that region.

depth-of-edge influence zone—the transition zone between the edge of agriculture, pasture,
or urban land uses (see below) and core forest (see definition above) in which it is assumed
that ecological processes such as fire regime and microclimate are altered. In TAMARIN,
users can specify the distance of the depth-of-edge influence zone, although for Bahia we
provided a default value of 300 m based on Gascon et al. (2000).

easement opportunity cost—this represents an estimate of the opportunity costs to the
landowner if their land were included in the conservation corridor. Because the owner
maintains title to the land and some opportunities to use it, this value is less than the land
value (see below). For Bahia, several estimates of easement value were made based on
different assumptions of the opportunity costs for forest and tree-shaded cocoa land
(Section 3.1).

edge forest—forest adjacent to agriculture, pasture, or urban land uses and therefore
subject to conditions hostile to forest regeneration, which leads to a decline in its value as
forest habitat for interior-dwelling species (in contrast to core forest) (Gascon et al. 2000).

Environmental Benefits Index (EBI)—we use this term that was coined for the USDA
Conservation Reserve Program (described in Chomitz et al. 1999) as a measure of the
ecological feasibility of restoring or protecting a planning unit. For Bahia, several versions of
an environmental benefits index are provided in TAMARIN based on different assumptions
of the value for secondary forest and cocoa land (Section 3.1).

framework—we refer to TAMARIN as a framework because it structures the design and
evaluation of alternative conservation strategies. We prefer this term to “model”, which
implies an underlying ecological or social process.

gap-crossing distance—the distance across non-forest habitat that a species is known or
believed to be able to traverse to move between forest patches. Patches of forest
separated by less than this distance are considered part of the same functional patch. In
TAMARIN, we assume this distance to be 1km for secondary forest and other forested
media (e.g., cabruca, other tree-shaded cocoa, caatinga) and 0.5 km for agriculture. In
Bahia, the values were based on expert opinion about the ecology of the yellow-breasted
capuchin, although users have the option to modify this variable.

incentive offer— a potential payment to a landowner in exchange for a modification in land
use that will achieve desired conservation objectives, prescribed by a formula or schedule.
Landholders accept or reject the offer depending on whether it is greater or less than the
opportunity costs associated with the change in land use. In TAMARIN, we assume that
incentive offers are equal across the entire corridor, although the user can specify the
amount in a given scenario.



land value—the market value of the land and improvements. In Bahia it was imputed from a
survey of ~250 farms in the corridor and represents the price of acquiring title to the land
suitable for forest restoration i.e., all land cover categories except water, urban, cloud, and
shadow (Section 3.1).

matrix—the dominant land use or land cover of a region in which forest fragments are
embedded. Some matrix types are more conducive to biodiversity conservation than others.
For instance in Bahia, a matrix of tree-shaded cocoa is more valuable to the maintenance of
forest primates than a matrix of pasture.

planning unit—the spatial unit used to analyze patterns of biotic diversity and land values in
order to identify priority areas. For this project, we have chosen square cells of 990 meters
on a side as the planning units. These units are large enough to compensate for uncertainty
in the spatial data and to keep the size of the analysis manageable, yet small enough to
allow flexible selection of alternative scenarios that respond to spatial variation in costs,
restoration suitability, and existing land uses.

rastinga—arboreal or herbaceous open canopy vegetation growing on costal plains of Bahia.

redundancy—designating multiple sites for each element of biodiversity as backups to guard
against catastrophic environmental or population fluctuations (Shaffer and Stein 2000).

representation—maintain the full range of biodiversity, including species, habitats,
environmental types, and genetic variation by designating a network of sites that saves
some of everything (Shaffer and Stein 2000).

reserves—lands legally protected for biodiversity conservation.

resilience—designating sites of adequate size so that natural processes can operate at their
characteristic spatial and temporal scales and increase the likelihood of maintaining species
(Shaffer and Stein 2000).

restored forest—forest that regenerates spontaneously (if near existing mature forest or
other forested media, e.g., cabruca) or through reforestation (if isolated from existing forest)
if the current land use is abandoned, such as in response to an incentive payment to the
landowner.

scenario—an alternative strategic allocation of land uses guided by a set of assumptions
and choice of planning units for conservation intervention.

tree-shaded cocoa—Theobroma cacao L. trees that produce cocoa beans that are used to
make chocolate growing in the shade of larger trees. In Bahia, cocoa trees are being shaded
either by native trees (cabruca) or by exotic tree species (e.g., Erythrina spp.).

viable habitat unit—a patch, or functionally connected set of patches (within the gap-
crossing distance—see above), that is at least as large as the specified minimum size to
maintain a population of one of the flagship species of the corridor e.g., the yellow-breasted
capuchin in Bahia. A viable habitat unit can include both core and edge forest, although
scenarios are evaluated in part by the proportion of edge forest. In TAMARIN for Bahia, we
assumed that this minimum area is 10,000 ha, based on a population viability analysis,
although users can modify the size for a scenario.



1.1 Background

Because environmental and socioeconomic conditions and conservation goals are location-
specific, we have developed a general methodology and applied it to a specific, policy-relevant
context linked to a World Bank-executed project: the construction of the Central Atlantic Forest
Biodiversity Corridor in south Bahia. The Atlantic Forest is by far the most threatened major
ecosystem in Brazil, with less than 8% of its original area remaining; Conservation International
places it third on its list of the nineteen highest-priority habitats for conservation on the planet
(based on the combination of threat and uniqueness). The northeastern section of this forest in
south Bahia is now reduced to relatively small, mostly nonviable fragments. The operational
problem is to deter further forest conversion and to induce abandonment of pasture and
agriculture in the interstices between forest fragments. This will result in forest regrowth,
reconnecting fragments into viable ecosystems. The impetus for the TAMARIN framework was
a desire by the World Bank to examine the potential for novel economic incentives targeted at
landholders, including purchase of conservation easements, sale of tradable development
rights, and environmental services payments.

The challenge is to find cheap, enforceable approaches that result in desirable land use
configurations. Pasture abandonment in different locations will have different ecological impacts,
depending on proximity to existing fragments. Costs of abandonment, and of protecting forest,
will also vary from place to place.

The underlying premises of the project in Bahia were:

1. That there is substantial variation in opportunity costs of land within areas of conservation
interest

2. That economic instruments can, in principle, exploit this variation to achieve conservation
goals at lower cost than is possible via command-and-control approaches

The strategies for restoration can be quite complex because conservation planning must
balance multiple objectives and constraints, including cost efficiency. What seems obvious to
achieve one obijective (e.g., protecting habitat-friendly land use practices) may not satisfy social
goals or may cost too much. The TAMARIN framework encourages planners to focus on
specific measurable conservation objectives and then develop scenarios to evaluate rather than
focusing initially on conservation actions.

Conservation science has identified three fundamental principles for conservation of
biodiversity: representation, resilience, and redundancy (Shaffer and Stein 2000). It is critical to
maintain the full range of biodiversity, including species, habitats, environmental types, and
genetic variation by representing this range in a network of sites managed primarily to ensure
their persistence. Besides affirming the intrinsic value of biodiversity, representation is a hedge
against the loss of species that play a crucial but undiscovered role in ecosystem functioning or
that could be a source of new biotechnological material. Even with samples of all biodiversity
elements represented in multiple sites, each site must be resilient or resistant to impacts from
adjoining landscapes. The most basic solution to this is to protect or restore sites of adequate
size so that natural processes can operate at their characteristic spatial and temporal scales. If
only a single large, resilient sample of each species or habitat is preserved, catastrophic
environmental or population fluctuations could still extirpate it. Therefore, the redundancy
principle prescribes managing multiple sites for each element of biodiversity. This replication of
sites also reinforces the representation goal by requiring samples across environmental
gradients with the corresponding variation in genotypic and ecotypic responses. With limited
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resources, planners must choose between optimizing for resilience (size of each reserve) and
redundancy (number of reserves). Pelletier (2000) found that if species survivability is low in the
matrix, then single large reserves are optimal over many small reserves. In other words, the
minimal strategy to protect the whole ensemble of biodiversity in a region is to manage a system
of relatively large sites (not necessarily reserves) that represents several viable populations of
all species.

Many studies have reported on the degradation of forest fragments in a zone around their
perimeter (e.g., Gascon et al. 2000). Adjacent land use practices such as burning modify the
disturbance regime, which in turn can change the structure, composition, and function of the
forest edge for hundreds of meters. Not only does this alteration reduce the resilience of the
fragment, it is a dynamic process of attrition that in a harsh landscape matrix will continue to
penetrate inward and reduce the size of the core habitat. In fact, fragments as large as 1000
hectares could be entirely within this altered edge zone (Gascon et al. 2000) and thus be poor
representatives of primary forest habitat.

Conservation science has been more equivocal on the subject of connectivity and distance
between (or proximity of) protected sites (Shafer 2001). Designing a network of closely spaced
sites may foster connectivity with interpopulation gene flow and recolonization opportunities.
Having sites near each other, however, increases the risk of extinction from catastrophic events
such as wildfire, disease, and extreme climate events. The ultimate form of habitat connectivity
is to maintain corridors or linkages between habitat patches. These linkages contain the same
habitat as the patches or at least habitat that is adequately suitable for a species to traverse.
The corridor literature is similarly ambivalent about the pros and cons. Species differ in their
behavioral response to corridors. Some species use them; some do not. The value of a
corridor depends on its length and width, and thus a linkage of suitable habitat types is not
automatically of benefit to a species. Long thin corridors by definition contain mostly edge
habitat. For many species, this may increase their exposure to predators. At the biogeographic
scale of the study area in Bahia, we have not found adequate supporting information to justify
the specification of linkages between forest patches as a requirement of the desired landscape
configuration.

If we assume there are two forest patches in a planning region, one larger and one smaller.
There are at least five strategies, according to Possingham et al. (2001) regarding where to
invest in a fixed amount of restoration, each of which increases representation equally in terms
of hectares protected:

1. Make the existing large patch bigger (increases resilience);

2. Make the existing small patch bigger (increases resilience);

3. Link the two patches (increases connectivity with mixed effects on resilience, decreases
redundancy);

4. Make one large patch (increases resilience, decreases redundancy);

5. Make many small, widely distributed patches across the region (increases redundancy).
Each strategy helps achieve some conservation objectives, such as representation across
environmental gradients, connectivity, or viability through larger contiguous habitats. Yet each

strategy alone cannot satisfy all objectives simultaneously. The implications of the strategies on
their relative effectiveness are not always obvious. The implications of various strategies on



other land uses, regional economics, etc. must also be considered. Thus planners must
examine the trade-offs between strategies.

1.2 Basic Operations

TAMARIN is a planning support system to assist in designing a conservation corridor. The
figure below illustrates both the major processing steps in TAMARIN and how the software fits
into the overall planning process. Prior to running TAMARIN, it is assumed that the required
GIS data have been compiled or modeled. Once scenarios have been designed and evaluated,
a decision must be made and the program implemented, with appropriate monitoring to
determine if the desired landscape is being achieved (Ofate et al. 2000).

Within TAMARIN, the software performs two basic kinds of operations. Steps 1 and 2 in the
flowchart form the design phase of the process, and steps 3 and 4 are the evaluation phase.
These steps will be discussed in greater detail in Section 5.
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1.3 Selection Options

There are many techniques for designing a conservation scenario, and TAMARIN
accommodates several of them as outlined in this section. More details about the mechanics of
selecting planning units for a scenario are provided in Section 5.1.2, this section merely explains
the range of choices.

1.3.1 Select Graphically

You can select planning units interactively using ArcView’s selection tool, either by clicking on
planning units individually or clicking and dragging the cursor across a rectangular area. This
works well when you have specific sites in mind for a scenario.

1.3.2 Select by Query

Alternatively, you may not know exactly where to restore forest but have a good understanding
of the characteristics of the best locations. Then you can query the attributes of the planning
unit coverage by Boolean logic. For instance, you can query for planning units with attribute
values =, >=, <= a given land value or restoration suitability.

1.3.3 Select by Theme

You or someone else may have created a shapefile (either previously or using the ArcView
graphic tool and converting the graphic into a shapefile) that portrays a scenario. By choosing
the ‘Select by Theme’ option, you can pick this shapefile with the browser and have it select all
planning units that occur within the boundary of the polygons.

Note: If the theme has been digitized externally from the toolbox, it should be in the same
projection as the standard themes, as described in Section 3.

1.4 Outline of the Manual

The rest of the manual is organized as follows:

Section 2 describes the installation process, system requirements, and utility programs;
Section 3 describes the required and optional input GIS themes and their attributes;
Section 4 illustrates the customized menus and buttons created for this application;

Section 5 explains the step-by-step procedures for designing and evaluating conservation
scenarios and their impacts;

Section 6 demonstrates the steps for a hypothetical scenario;

Section 7 outlines how TAMARIN could be modified either for updated GIS themes for Bahia or
for adaptation for use in other corridor projects.



2. INSTALLATION AND SYSTEM REQUIREMENTS

TAMARIN requires the following hardware and software:

o ArcView 3.0+ with Spatial Analyst 1.0+ extension

¢ Microsoft Windows 95/98/2000/NT/XT operating system

o Some GIS operations on this large data set are very computationally intensive. We
recommend your computer have minimum of 128 megabytes of RAM and a fast processor.
A high-resolution display is useful for displaying the graphic and map data.

o The ‘Landscape Configuration’ menu generates several very large grids as temporary files.
We recommend at least 1 gigabyte of available disk space in the partition where TAMARIN
is installed to accommodate these grids. Once the script has executed the large temporary
grids are automatically removed.

2.1 Installing and running TAMARIN as ArcView project

The copy of TAMARIN that you possess is in one of two formats, either an installation CD or a
zip file (received via ftp on request). To install TAMARIN from an installation CD, insert the disk
into your CD drive and wait for an installation dialog to appear. Follow the series of dialogs to
finish the installation. If your auto launch is disabled, start the installation by double clicking on
Install.msi, located on the distribution disk. In the case that you received TAMARIN as a zip
file, simply use WinZip or similar software to unzip the file.

Once you have performed those steps, to run the TAMARIN project, double click on
tamarin.apr (ArcView project file located in TAMARIN directory) or open the project using
ArcView by selecting ‘File>Open Project...” and select tamarin.apr.

Note: Avoid using directory names comprised of several words with spaces between them (e.q.,
“C:\My Documents” MAY NOT ALWAYS WORK CORRECTLY).

2.2 Running TAMARIN as ArcView extension

Use this option only when you intent to build a new TAMARIN project from scratch (e.g., when
migrating TAMARIN framework to a different region). After installing TAMARIN, double click on
tamext.bat located in the tamext directory. This batch file copies the tamarin.avx (TAMARIN
extension file) to AVHOME\ext32 directory; the ArcView program will start automatically.
Proceed by loading the TAMARIN extension: click: ‘File>Extensions...” and activate the
TAMARIN extension by clicking the checkbox (all associated scripts will load into the ArcView
project). Proceed with building your new TAMARIN project (see Appendix B for complete set of
steps).

Note: If AVHOME is not set as C:/ESRI/AV GIS30/ARCVIEW, which is the standard location of
the ArcView program, use the text editor to edit tamext.bat so that the correct location of your
AVHOME will be reflected.




2.3 TAMARIN Project Error Reporting

Each time TAMARIN starts, an AVENUE start up script (Tam.Startup) runs a series of checks
and report errors caused by the omission of required datasets or by the use of inappropriate
names for them. If the error occurred, a popup window, similar to the one below, appears, and
a log of all errors is written into a text file created in a current TAMARIN directory. This error log
file lists all encountered errors and suggests actions for correcting them. The name of the error
log file includes the date and time of creation.

September 17, 2003 07 32 Pkt far details.

e

2.4 ArcView Project Pathnames Update Utility

O Errorz) detected during the TAMARIM startup, See "Ermor_log

Once you save your TAMARIN project, the pathnames of data files associated with the project
will become hard-coded. As long as you keep working in the same directory into which you
initially saved your project you will not need to update them. If you move the project to any
other location you will need to update the pathnames. To do this, go to the Exploring window
and double-click on the APR-Tool.exe icon or filename (this helpful program by Nicolo Pitsch
can be obtained from http://qis.esri.com/arcscripts/scripts.cfm if it is not obtained with the
TAMARIN package). Click the ‘Open’ button and select tamarin.apr as the input project name
(Old file). The default name for ‘New file’ will be tamarin_new.apr. Change this name if you
wish. Click the ‘Replace’ button and enter the old pathname and the pathname that matches
the directory structure where you copied the files.

x|

Search: Iu::a"mirna"pru:uieu:ts.-’tamarina’tambahiaa’tamsmaIME j Replace all |

Replace: Iu::a"tamarin j Close |
¥ From top

Next, click the ‘Check paths’ button to make sure the folders actually exist. Then press the ‘OK’
button to make the global change in the project file.


http://gis.esri.com/arcscripts/scripts.cfm

,‘-“J:' APR_Tool (1.72) by Micolo Pitsch Email: nicolo.pitschi@er - |EI|£|
Language
Replace paths within ArcView Project - Files £1 Close |
~=elect Arciiew Project-File

gen. . I 1d file: i oprojectsiTamarintTamBahisiTamSmalld 2 tamarin.agar

Hew file: C:Mirotproject=\TamariniTamBahist TamSmalld 2tamarin_nesw apr

—Replace pathz in new file

[9]24 I Check paths |

Directories... I

QI path INEW piath |
cimiroforojectstamarintambahis tamsmall4 24 c:amarind

cimirodarojectztamarintambahiatamamalld 2infof c:tamarindinfas

FE0mil FE0mil

comirodorojectstamarintambahiztamamalld 20is_inputs | oo tamarindgis_ingputs
cimirodarojectztamarintambahiatamamalld 2igis_inputhir o tamarindgis_inputinfal
cmirofprojectstamarintambahiatamsmald 2 vvorking! | o tamarindeeorkings
cimirodarojectztamarintambahia tamamalld 2 dvvorkingind o tamarinisorkinginfal
Fanents Fanents

c:imirofprojectstamarintambahial c:imirofprojectstamarintambahial

After fixing pathnames, double-click on the tamarin_new.apr filename (or whatever you chose
to call it) to run TAMARIN.

2.5 ArcView Views Resize Utility

The default window size for TAMARIN is set to your maximum screen resolution. The view
windows (those with maps) are automatically scaled to fit in this window. If you choose to resize
the application window, the view windows may become too large or too small. Click on the
button with the three dots to automatically resize all the view windows to the appropriate size.
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3. REQUIRED AND OPTIONAL INPUT THEMES

TAMARIN for Bahia was distributed with several GIS themes that are the basis for conservation
scenario design and evaluation. Several additional themes were provided for geographic
reference and visualization. This section briefly describes the required and optional themes.
Users may substitute new versions of any theme. Guidance is provided in Section 7. These
substitute themes must be in the same map projection and datum as the originals. For Bahia
project, all themes have the following ARC/INFO projection properties:

PROJECTION UTM

UNITS METERS

ZONE 24

SPHEROID SOUTHAMERICAN1969

DATUM SAN_C

YSHIFT 10000000 /* FOR THE SOUTHERN HEMISPHERE
PARAMETERS

3.1 Planning Units (PU) (Required)

This shapefile (e.g., cell990m.shp) is used for selection of priority conservation areas in a
scenario.

At the regional scale of the Corridor project, it is neither appropriate nor feasible to use parcels
as the basic spatial unit for selection. Maps of parcels often do not exist, and the information on
costs, environmental benefits, etc. are too uncertain, both in value and geographic location, to
be reliable at the parcel scale. In Bahia, TAMARIN uses a square grid of planning units that are
990 x 990 m. These are the spatial units that can be selected by various means (see Section
1.2) for either protection or restoration. However, users should be aware that the areas of
planning units are not identical to one another even though they are all represented by equally
sized squares. For example, in Bahia, most planning units are composed of 98.01 ha of land
(990 x 990 m squares), however, some of the 990 x 990 m squares contain a smaller eligible
area for selection. This is because portions of the grid cells that contain water, urban, and
protected areas were excluded from consideration as a potential conservation area. As a result,
the values reported in the Hectares attribute may range from only a few hectares to the entire
area of a square (98.01 ha). This has certain consequences for the selection and sorting of
planning units further described in Section 5.1.4.

Besides the Hectares attribute mentioned above the data fields include: Land_Value, which is
the predicted or imputed land value for the planning unit (i.e., the cost to acquire the land in the
unit); Easement_Value, which is the imputed value of the resource potential of the land without
considering the land value (i.e., the minimum cost to acquire a conservation easement); and
Environmental Benefits Index, which is a suitability score for restoration or conservation based
on the current land cover of the unit. Chomitz et al. (2004) estimated Land_Value using a
multivariate regression hedonic model with variables for soil properties, land cover, distance
from roads etc. (for more details see Appendix D). Besides economic values and environmental
benefits, the attribute table contains fields that can be useful in selection queries, such as the
percentage of a unit with mature forest, the population density, and variables used in the
hedonic models. One field contains our interpretation of whether a unit can be restored as
forest by natural regeneration or not, based on an assumption that this process can only
operate without human intervention (and cost) within 1 km of existing mature forest fragments.
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Because there is little experience with conservation easements in Bahia, there were
uncertainties about the magnitude of opportunity costs. Consequently, we provided four
alternative assumptions about the opportunity costs that should be paid to landowners as
environmental compensation (or easement value) as an incentive to participate in restoring the
corridor. Users can select the alternative Easement_Value as the conservation intervention.
Here are the four alternatives and their assumptions. In the explanations of the options, ‘actual’
value is the imputed Land_Value in a unit with its current mix of land cover types suitable for
growing forest. Its ‘value if all forest’ is the land value predicted if the unit were all forest and
could not be used for agriculture or timber. The easement value (or opportunity cost) is some
proportion of the difference between the two. Each alternative uses different assumptions about
this difference. The value is the sum of the easement cost for all lands within a planning unit
that contain forest or could be restored as forest. That is, land use such as urban and cover
types such as water or mangrove incur no cost, nor do they contribute to the forest conservation
objectives and therefore they were excluded from the value imputed for south Bahia.

o Easement Value1— We asserted that the easement value was equal to the difference
between the “as is” land value, and half of the “all forest” land value. This assigns a
relatively low opportunity cost to maintenance of mature forest. EV1 = 'actual’ value — (value
if all forest/ 2).

o Easement_Value2—This assigns a zero opportunity cost to maintenance of mature forest,
based on the assumption that current law forbids cutting mature forest (also assumed in #3
and #4). EV2 ="actual' value - value if all forest.

o Easement_Value3—This assigns a zero opportunity cost to maintenance of mature forest or
tree-shaded cocoa. EV3 ="actual' value - value if (tree-shaded cocoa stays tree-shaded
cocoa and everything else is forest).

o Easement_Value4—This assigns a zero opportunity cost to mature forest maintenance and
a relatively low cost to tree-shaded cocoa maintenance. This is the default easement value
for south Bahia, given the current legal, social, and economic situation. EV4 =.5* (EV2) +
S5*(EV3).

A blank User_Defined_Easement field is also provided to allow planners the option of making
different assumptions about the opportunity costs that must be compensated to motivate
landowners to conserve forest. Planners can recalculate this field prior to designing and
evaluating a scenario.

Because spontaneous forest restoration in Bahia is unlikely beyond approximately 1 km from
existing forest, we attributed an additional cost of R$2000/ha for manually-intensive
reestablishment (Viana et al. 1997) when the Restorable field contains a value of ‘N’.
Otherwise, there is no restoration cost.

There are also alternative assumptions about the Environmental Benefits Index variable. We
have computed eight alternative values for this index, based on different assumptions or criteria
about the value of tree-shaded cocoa and/or secondary forest in a unit. The eight alternative
indices are described below. The extent of each cover type is also stored in the planning unit
attribute table.
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o EBI_Orig—this was the original environmental benefits index we calculated. It gave
greatest weight to mature forest, only gave moderate weight to tree-shaded cocoa if mature
forest was present, and relatively low weight to secondary forest if it was in a matrix with
mature or tree-shaded cocoa, as follows:

Define the function D(x)=0ifx=0
=1ifx>0
let P_mature = proportion of mature forest in a given planning unit
let P_cabruca = proportion of tree-shaded cocoa in a given planning unit
let P_secondary = proportion of secondary forest in a given planning unit
generate:
P_cabprim = P_mature + P_cabruca
then
EBI_Orig =
5*P_mature +
5*P_wetland +
3 * P_cabruca * D(P_mature) +
2

P_
P_secondary * D(P_cabprim)

¢ EBI _Cab— EBI_Orig gave no weight to planning units with tree-shaded cocoa without
mature forest interspersed with it. From the methods for mapping land cover, this situation
applied to most units with tree-shaded cocoa and so tree-shaded cocoa generally scored
very low. This variation on EBI gives value to tree-shaded cocoa in any context, while
mature and secondary forest are the same as in EBI as follows:

Define the function D(x)=0ifx=0
=1ifx>0
let P_mature = proportion of mature forest in a given planning unit
let P_cabruca = proportion of tree-shaded cocoa in a given planning unit
let P_secondary = proportion of secondary forest in a given planning unit

generate:

P_cabprim = P_mature + P_cabruca
then
EBI_Cab =

5*P_mature +

5*P_wetland +

3 * P_cabruca +

2 * P_secondary * D(P_cabprim))

o EBI_Pref—A historically preferred variation that modified EBI_Cab slightly. It gives
moderate weight to tree-shaded cocoa if mature or secondary forest is present and to
secondary if either mature or tree-shaded cocoa is present; otherwise, tree-shaded cocoa
and secondary receive a low weight as follows:

Define the function D(x)=0ifx=0
=1ifx>0
let P_mature = proportion of mature forest in a given planning unit
let P_cabruca = proportion of tree-shaded cocoa in a given planning unit
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let P_secondary = proportion of secondary forest in a given planning unit
generate:

P_anyfor = P_mature + P_secondary

P_cabprim = P_mature + P_cabruca
then

EBI_Pref =
5*P_mature +
5*P_wetland +
3 * P_cabruca * D(P_anyfor) +
3 * P_secondary * D(P_cabprim)+
1 * P_cabruca * (1 - D(P_anyfor)) +
1* P_secondary * (1 - D(P_cabprim))

EBI_Pref_per LV—this index was calculated according to the following formula:
EBI_Pref_per_LV = 1000 * Nourbwat_ha * EBI_Pref / Land_value

where Nourbwat_ha = total area in hectares of land cover categories suitable for supporting
forest growth except urban, water, no data, and area which falls inside an existing protected
area; Land_value = total monetary value of the above categories. Nourbwat_ha and
Land_value are standard attributes listed in a planning unit theme (see Appendix E for
details).

EBI_5—A currently preferred variation of EBI_Cab. It gives a moderate weight to tree-
shaded cocoa and secondary forest if mature forest is present. If mature forest is not
present, tree-shaded cocoa and secondary forest in combination with each other or
standalone receive a low weight as follows:

Define the function D(x) =0ifx=0

=1ifx>0
let P_mature = proportion of mature forest in a given planning unit
let P_cabruca = proportion of tree-shaded cocoa in a given planning unit
let P_secondary = proportion of secondary forest in a given planning unit
then

_wetland +

_cabruca * D(P_mature) +
_secondary * D(P_mature) +
_cabruca * (1 - D(P_mature)) +
_secondary * (1 - D(P_mature))

EBI_5_per_LV—was calculated using the same formula as for EBI_Pref_per_LV calculation,
except it uses the EBI_5 as numerator instead of EBI_Pref.

EBI_Core—the previous EBI indices are based solely on the content of each planning unit.
We also include an EBI that accounts for the context of the planning unit as well. It is
designed to identify potential core areas for forest blocks. First the land cover theme was
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reclassified into suitability values adapted from a table developed at one of the PROBIO
workshops. This table rated each cover type for structural complexity, soil conservation,
regeneration potential, and dispersal potential and then aggregated into an overall rating.
Second, the 30 m pixels are summarized over a circular neighborhood 990 m in radius
around each focal pixel using the FOCALMEAN function. Each pixel is assigned the mean
suitability value of its neighborhood. Then the neighborhood values are summarized for
each planning unit, again by calculating the mean and normalizing to a maximum value of
5.0.

o EBI_CORE_per_LV—was calculated using the same formula as for EBI_Pref _per LV
calculation, except it uses the EBI_Core as numerator instead of EBI_Pref.

A blank User_Defined_EBI field is also provided to allow planners to make different choices
about the factors of environmental benefits they wish to emphasize. Planners can recalculate
this field prior to designing and evaluating a scenario.

Note: We have created planning unit theme and its attributes as part of TAMARIN. Information
contained within these attributes can be used in selecting planning units or in evaluating
scenarios (see Appendix E for a summary of all attributes). You may wish to use a different
spatial unit for designing and evaluating scenarios (e.g., census tracts, or reqular units of a
different spatial resolution). TAMARIN asks which theme to use for planning units during the
‘Define a scenario’ dialog. Simply select your theme instead of the default version we have
provided. However, be aware that your theme must contain the identical set of attributes as the
default theme to prevent errors (see Appendix B for a guide to create a new planning unit

theme).

3.2 Business-As-Usual Scenario (Required)

TAMARIN compares conservation scenarios to the current situation and to the land use trend.
This raster theme portrays a forecast of future land cover/use in the absence of conservation
intervention. The modeling framework asks the user which theme to use as the business-as-
usual forecast, and users can create their own (but it should be saved into the options folder).

In the absence of quantitative information on socioeconomic drivers of future land use change in
Bahia, authors employed a simple deterministic model of change, based on the following
assumption: the recently observed land use trends will continue over the next two decades if
conservation interventions are not applied. In particular, primary forest will no longer be
converted to other uses because it primarily occupies marginal lands and is legally protected
when growing on steep slopes and within a certain distance from a river. However, it will
continue to be degraded into secondary forest through firewood gathering and other resource
extraction, hunting, and other human-related impacts. Secondary forest will be permanently
converted to pasture or agriculture except in areas where it is near primary forest; in such
situations, it will remain secondary forest. Cabruca and other tree-shaded cocoa will be partly
replaced by other forms of agriculture including sun-grown cocoa, coffee, or crops or pasture
except in areas where previously established on soils with the highest agricultural production
capacity (prime farmland), on steep terrain (larger than 70% slope) or on floodplains. However,
for convenience of processing tree-shaded cocoa was actually reclassified to secondary forest
based on an assumption that it ‘acts like’ secondary forest when buffering edges and facilitating
gap crossing. Pasture and agriculture will generally remain unchanged, as we assume no
spontaneous abandonment and regeneration of farmland. Bare land is assumed to be a
temporary state of agricultural land that is reclassified as agriculture/pasture for the future.
Urban land uses and other habitat types (e.g., mangrove, wetlands, water bodies) cannot be
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converted into forest and are assumed to remain in their present condition. Similarly, we did not
anticipate changes for restinga and caatinga. The BAU layer was constructed to reflect this
situation by reclassifying the current land cover layer of southern Bahia.

It is important to remember that the decisions about the future land cover under BAU scenario
for southern Bahia was the authors’ best guess based on personal observations of practices of
local people in the area (for summary of all rules see Table below).

3.3 Restoration Interventions (Required)

This raster theme reclassified existing land cover/use (Section 3.6 below) into the highest level
of habitat possible if the pixel is in a planning unit that is selected for conservation action. We
assume that restoration or regeneration produces a class we call ‘restored forest’, which will be
similar to secondary forest for the short term, but will eventually resemble primary forest. The
reclassifications applied to the current land cover/use are given in the table below.

After the user selects planning units for conservation intervention, by any of the methods
discussed in Section 1.2, the restoration theme is extracted for those units and then merged
with the Business-as-Usual scenario (section 3.2) for unselected units to predict the future land
cover/use pattern for the scenario.

Table of assumptions about transitions in land use/cover form current to the future without or
with protection/restoration

Land Cover Class

Business As Usual Scenario

Restoration Scenario

Mature Forest

Secondary Forest

Mature Forest

Secondary Forest

Secondary Forest (see in the text) if
near Mature Forest; otherwise
Pasture/Agriculture

Restored Forest*

Tree-shaded cocoa

Secondary Forest on fertile soils, in
steep terrain or on flood plains;
otherwise Pasture/Agriculture

Restored Forest*

Eucalyptus Plantation | No change No change
Pasture/Agriculture No change Restored Forest*
Bare Soil Pasture/Agriculture Restored Forest*
Restinga No change No change
Caatinga No change No change
Mangrove No change No change
Wetlands No change No change
Water No change No change
Urban No change No change
No Data No change No change

* If pixel is within 1 km of mature forest, restoration is spontaneous; otherwise a reestablishment cost of R$2000 / ha is

imposed.
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3.4 Bioregions (Required)

The conservation objectives for the
Corridor are to preserve or restore
examples of forest in each bioregion.
For Bahia this layer was derived from
a vegetation map compiled by Wayt
Thomas and Andre Carvalho for the
Corridor project, based in part on their
previous research (Thomas et al.
1998). There are two formats for this
theme. The vector shapefile version
is used for visualization. The grid
version is used in summary analysis
to compare a scenario with the
bioregional conservation objectives.
The bioregions capture the major
patterns of biodiversity in the corridor.
From coast to interior, the vegetation
grades from lowland wet forest to
semi-deciduous Forest. The north to
south zonation recognizes the
biogeographic barriers of the Rio de
Contas and Rio Jequitinhonhia.
Distinct endemic flora and fauna
occur to the north and south of both of
these maijor rivers.

3.5 Prime Farmland (Optional)

Allocation of the best farmland to
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conservation purposes conflicts with social goals such as self-sufficiency in food production. In
the absence of a map specifically delineating prime farmland, we use a map derived from
Radambrasil’'s Potential Use of the Land map (Brasil, Ministério das Minas e Energia 1981,
1987). This map classified soil and climate attributes into a set of seven classes (six of which
occur in the Corridor project area) and then rated each class for its potential for agriculture and
other land uses. Only one class, called Lavoter, is rated as highly suitable for agriculture in the
Corridor. We extracted the polygons with this class and converted it to a grid as a coverage
labeled ‘AOSI’. It is used in the summary analysis.

3.6 Paved Road and Urban Areas Mask (Required)
TAMARIN treats paved roads and urban areas as barriers that fragment forest blocks. In Bahia
this grid theme excludes lands within 200 m of all paved roads and urban areas when grouping

pixels into forest blocks. It was derived from shapefile theme of roads and land cover
classification (described below) using ArcView according to steps listed in Appendix C.
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3.7 Current Land Cover/Use (Required)

The land cover/use layer functions not only as a reference layer that guides a TAMARIN user in
selecting planning units, but also as a base layer for deriving the BAU layer described above.
The construction of the layer was based on an interpretation of eight adjacent Landsat-5
Thematic Mapper images with a pixel size of 28.5 m (Landau et al. 2003a). Seven of these
images covered almost the entire area of interest, and were acquired within a five month period
between October 1996 and February 1997. The only exception was a single image used from
August 1994 that covered the most northern area. Prior to the interpretation the six available
optical bands of each image were georeferenced using reference points obtained from 1:100k
scale topographic maps, spectrally equalized and preprocessed into seven derived products.
These derived products were obtained from: principal components analysis, a calculation of
normalized difference vegetation index (NDVI), analysis of texture variance of band 7 and
applying a low pass filter to bands 5 and 7, and were subsequently used as inputs into the
ISODATA unsupervised classification process. This algorithm produced eighty arbitrary classes
for each image. These classes were then interpreted and assigned to new categories in
accordance with a legend defined by the official Brazilian vegetation classification system
(Veloso et al. 1991). The resulting land cover/use classes are listed in Table below. The
classification results were mosaiced together to produce continuous cover of the area.

Table of land use/cover codes in the GIS layer and corresponding class names.

GIS Code | Class Name
3 | Mature Forest (mature tropical forest and advance stage of regeneration “Capoeirao”)
4 | Secondary Forest (initial stage of regeneration “Capoiera”)
5 | Tree-shaded Cocoa (cabruca/cocoa shaded by exotic tree species, e.g., Erythrina spp.)
8 | “Restinga” Arboreal (arboreal vegetation on coastal plains)

9 | “Restinga” Herbaceous (herbaceous vegetation on costal plains)
10 | “Caatinga” (savana with open xerophytic deciduous vegetation)
11 | Eucalyptus Plantation (monoculture plantation of Eucalyptus spp.)
12
13

6

2

1

Pasture/Agriculture (including rubber plantations)
Bare soil
Mangrove
Wetlands (including “Brejos” and “Varzeas”)
Water

14 | Urban
No Data | Non classified areas (No data, cloud, shadow)

3.8 Existing Reserves (Optional)

This vector shapefile depicts all known nature reserves in the Bahia corridor that was compiled
by INCRA and supplemented from other sources for recently established reserves and major
RPPNs (Landau and Resende, 2003a). Area de Protegida Ambiental (APA’s) or
Environmentally Zoned Areas were not considered protected for biodiversity as they are
managed primarily for tourism. It is assumed that reserves are and will continue to be
protected. This theme is included as a visual aid for selecting additional sites to expand/buffer
(increase resilience) or to complement the existing reserves (increase representation).
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3.9 Roads (Optional)

Roads are important geographic features for orienting a user in the map display. They also
have significant impacts on land use, land value, and habitat value. Therefore, there is a benefit
of having a shapefile version of roads for visualization and a grid version that has been buffered
by road type. The latter theme is used in calculating edge effects on forest habitat and
separates tracts of forest into smaller fragments when determining the number of viable
fragments. For Bahia Landau et al. (2003b) had digitized topographic maps (1:100k), and then
updated them with newer information about paved roads.

3.10 Municipios (Optional)

These are the basic political units of the Corridor. They are provided here as base map features
for orienting the planning team in creating and evaluating scenarios. For Bahia the theme table
contains many attributes from the Census of Agriculture (IBGE, 1994), which can be displayed if
desired through standard ArcView tools such as the Legend Editor.

3.11 Cities (Optional)

Cities are also useful landmarks for orienting a planning team. A subset of all populated places
in Bahia with at least a population of 25,000 people was extracted and annotated with their
names (Landau and Resende, 2003b).

3.12 Fresh Water (Optional)
Major rivers and lakes were extracted from the Digital Chart of the World (DCW) — an
Environmental Systems Research Institute, Inc. (ESRI) product originally developed for the US

Defense Mapping Agency (DMA) using DMA data. We used the DCW 1993 version digitized
from 1:1,000,000 scale maps.
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4. CusTOMIZED GRAPHICAL USER INTERFACE

We customized ArcView to make TAMARIN more useful for corridor planning. Several menus
were added in the ViewGUI (see Section 5) and a series of buttons were added to the ViewGUI
button bar.

£ E3 KN N [

The hut button always resets the current working directory to the root directory of TAMARIN.
This is useful if you have used the browser to navigate to other folders and are having trouble
navigating back (or if TAMARIN is having trouble finding files).

The dollar sign ($) button can be used when selecting planning units to discover how much the
selected units will cost. You can see what proportion of your budget is left or how much you
have exceeded it. This only works with the original planning unit theme, not with the new
shapefile created of the selected units following the budget constraint step.

The downward arrow (or horizontal lines that get narrower towards the bottom) is used to close
all table windows. TAMARIN can create many summary tables. When you are done reviewing
them, click this button and it will automatically close every open table window. The tables are
not lost or deleted. They can be reopened from the ‘Project’ window in the ‘Tables’ section by
double-clicking on the name or clicking once and clicking the ‘Open’ button.

The ‘3 dots’ button resizes the View windows according to the size of the TAMARIN window.
This can be useful when starting TAMARIN for the first time on a different computer with a
different screen resolution or when you simply resize the application window.

The Paper Clip and Redo buttons are used to save and recover a set of selected planning units.

This guards against accidentally unselecting units that you have chosen manually and that
would be tedious and frustrating to select again (see Section 5.1.2).
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5. ANALYSIS PROCEDURES

TAMARIN contains two categories of analysis procedures. You use the first category to design
your own scenario and the second to evaluate that scenario.

5.1 Procedures for Designing a Scenario

The procedures for selecting are divided into three sequential steps. First the planner defines
the parameters of a scenario in a form or dialog box. Next the planner selects planning units for
the scenario by one of the methods described in Section 1.2 above. The final step allows a
budget constraint identified in the scenario definition to be applied to the selection. These three
steps are described in detail next.

5.1.1 Define a Scenario

el Evaluation  FieMar Each scenario will have different parameters. The first step is to
Define a Scenario... define what those parameters will be for a particular scenario.
From the ‘Select sites’ menu, choose the first option, labeled
‘Define a scenario...”. This opens up a series of dialog boxes or
forms with a combination of text lines for typing names or values,
Single Batch Processing... scrolling lists of files to select from, and radio buttons for selecting
Multiple Bateh Processing... between mutually exclusive options. The results of this dialog are
written to a text file to document the scenario.

Select Planning Unitz. ..

LConstrain by Budget...

#! Scenario Parameters Window El

Enter Scenario Parameter

Enter zcenanio name [Up ta B characters] I $E0mil

Mame of planner I karnarin

Enter budget [leave blank if none] I EO000000

Commetits | Budget constraint of $60 million

Cantinue | Cancel

Each scenario is given a unique name in the first text box. Type a name that helps identify the
scenario but is no more than 6 characters long. Besides being written to the scenario text file,
this name is used in naming many of the new themes, tables, and charts that are generated by
the analysis procedures.
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The second text box asks for the name of the person (or organization) who created the
scenario. This is written to the scenario text file for documentation, along with the current date,
which is determined automatically by the software.

The budget for this scenario can be set in the third text box. The default value is to have no
budget constraint. If you enter a value, in arbitrary monetary units, this amount constrains the
number of planning units for which a conservation intervention can be applied. Setting a budget
lets you compare a single strategy with different budget levels or different strategies with the
same budget. If a budget constraint is applied, it may reduce the number of planning units that
you initially select (see Section 5.1.3 below for details). Click ‘Continue’ to proceed to the
second dialog window.

T orpnario ParametersWindow2 bl
il b =

Chonze the assumphions for this scenano

& Pay full land walue
" Pay eazement value

" Pay ather incentive offer

Minimum viable core habitat size [ha) I 10000

kbl suirm e Aan croccimn diskanes Far gancolboes (eal
MaRIMLWT Gap CToF=ing QiRance 1or agnouian imy

on
[
=]

v . T . | - . | o - . | I s e——————
rdar gap crozzing distance in secondary farest and ather forested media [ | 1000

Edge effects distance [m] I 300
Mumber of representations per region I 2
Bccept soenario | Cancel

In this second dialog there are three radio buttons for choosing the conservation intervention to
be used in this scenario. The first uses land acquisition. If the box is checked, the full purchase
price of the planning unit will be assessed against the budget. If the second button is checked,
the selected planning units will be conserved through some form of conservation easement. In
that case, the cost of conservation action only includes payment of the opportunity cost to the
owner. You will be asked later to select the alternative estimate of opportunity cost/easement
value. The third radio button indicates a scenario where a fixed payment is offered for
easements. Selecting this button triggers an input message window to specify the amount of
the payment in monetary units per hectare.

The first three text boxes control how forest habitat units are defined in the analysis procedures,
including representation goals. The first box sets the minimum size (in hectares) of a block of
mature and/or restored forest for it to be considered viable for maintaining native plant and
animal diversity, assuming no immigration of individuals or propagules from outside the block.
This is a difficult number to determine because it depends on the taxonomic group one is
considering. Thus we have tentatively allowed this to be set as a variable in each scenario and
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documented in the scenario text file. The default for Bahia is currently set at 10,000 hectares
based on modeling by Adriano Paglia of the probability of extinction for the yellow-breasted
capuchin. Note that Gascon et al. (2000) predict serious degradation from edge effects for
forest blocks smaller than 5000 hectares, whereas Chiarello (2000) sets this threshold at 20,000
hectares. The second and third of these parameters specify the maximum distance (in meters)
that species or propagules can travel across different land cover classes to reach nearby
fragments. A cumulative result of the two maximum gap-crossing distances, set at the default of
500 m for agricultural land, eucalyptus, restinga and bare land and 1000 m for secondary forest,
tree-shaded cocoa, caatinga and mangrove, defines the relative impedance for gap-crossing
between the remaining forest fragments (urban area and water are considered to be
impenetrable barriers). Fragments that are closer than the value of the relative impedance
distance at a given place are treated as being part of the same functional block. It is the block
that is compared to the minimum viable habitat size. The fourth text box asks you for the
maximum distance (in meters) that you believe human-caused effects propagate from the edges
of forest patches into their interior. The default value for Depth-of-edge-influence for Bahia is
set at 300 m (Gascon et al. 2000) although this depends on the type of disturbance and its
ecological impacts. This distance is used in calculating the amount of core versus edge forest
in a scenario. The last text box sets the number of separate habitat units needed in each
bioregion to achieve the desired conservation goals for the scenario. The default value is set at
two habitat units per bioregion.

When you have finished defining the scenario, click on the ‘Accept scenario’ button at the
bottom of the dialog window. You may also click on the ‘Cancel’ button to leave the dialog
without saving your choices.

Atfter clicking the ‘Accept scenario’ button, you will be asked to select three themes for the
analysis. The first theme contains the set of planning units from which to select a scenario.
Normally you should select cell990m.shp unless you are substituting your own planning unit
theme. The second theme depicts your forecast for the future in the absence of conservation
intervention (the business-as-usual scenario as described above). The third theme is your
choice for the restoration grid, to be used for planning units that are selected for conservation
action. TAMARIN will display a scrolling list of themes and ask you to select which theme to
use for the three types of theme. Simply click on the theme name and click ‘OK’. The default
business-as-usual theme is called ‘BAU’ and restoration theme is called ‘Restore’. You may
substitute your own theme for one or both of these provided your theme meets all the format
and data requirements of the default themes.

#2 Pick planning unit theme x|
Dhirectony: ||::'\.miru:u'\.pru:uieu:ts"\tamarin'\taml:uahia'\tamsmall42'\gis_input ok |
B bioregoutln.zhp - = e - Cancel
| | mio _ e |
B cell990mece. shp [= projects
B cell990mang. shp [= tarnarin
B cities.zhp [= tambahia
@ municipios [= tamsmall42 &+ Directories
B reserves sy | [T o
M roadssho ll 1 bioreaions LI
Data Source Types: Drrives:
| Feature Data Source =l = |
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#! Pick business-as-usual grid x|
Dhirectony: |u::'\.miru:u"-.pru:uiects‘\tamarin'\tambahia'\tamsmall42"u:uptiu:uns ok |
E bau = = '31_"\ (= Cancel |
B restore [= miro
[= projects
[= tarnarin
[= tambahia
[= tamnsmalld2 & Directories
— m ™ Libraries
- 1 info LI
Data Source Types: Drrives:
| Grid Data Source =l = E3

After prompting you for the themes to be used in the analysis, TAMARIN allows you to choose
among other alternative assumptions. The first choice is to select the Environmental Benefits
Index variable in the planning unit theme. For Bahia we have computed six alternative values
for this index, based on different assumptions or criteria, plus one you can compute yourself.
You will be shown a scrolling list and asked to select the name of the field you wish to use. The
seven alternative indices are shown below and are described in section 3.1.

4 PickEBI script X

Click on field with your choice of environmental
benefitz index

Ok

EBI_Cab

EBl_Core

EBI_Pref

EBILA

EBl_Core_per_LY

EBI_Pref_per_L

EBI_5 per_ LV e
User_Defined_EBI |

There are also several alternative assumptions about the opportunity costs that should be paid
to landowners as environmental compensation (or easement) as an incentive to participate in
restoring the corridor. If you selected Easements as the conservation intervention, you will next
be asked which of four easement value assumptions you wish to apply in the scenario. The four
alternatives are shown below and are explained in Section 3.1.
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¥

PickEasement¥alue scripk

=

Click an field with the preferred easement
walue

Easement_“alued

Eazement_“alue3
Easement_“alug?
Eazement_valuel
Llser_Defined_Easement

5.1.2 Select Planning Units

Section 1.2 described the three methods for selecting planning units for a conservation
scenario. This section provides greater detail on how the selection is performed in TAMARIN
for each method. The selection methods do not consider the budget constraint. The user may
select as many planning units as desired. Applying the budget constraint that was identified in
the Scenario Dialog in Section 5.1.1 occurs in the third step, described in Section 5.1.3.
Therefore, the planning units selected in this step form only a starting or tentative set. In all
selection options, the selected planning units are highlighted in yellow in the Analysis View
window.

r’f_:-’ Selection Options 3 il
Choose a selection method Ok,
|Se|eu::t graphically

LI Cancel

oelect by theme

Graphical selection—In this selection method, the planner uses the ArcView Select features
tool (see graphic of tool button below) to select planning units with the cursor based upon his or
her judgment about priority locations for conservation. Select the ‘Select graphically’ option in
the ‘Selection options’ menu. Clicking on a single planning unit in the Analysis View window will
select that unit. Clicking and dragging the cursor with the left mouse button depressed will
select all units within the rectangle drawn by the planner. To select additional units, hold down
the Shift key while clicking or clicking/dragging with the cursor. Selected planning units will be
highlighted (in yellow). To unselect planning units, hold down the Shift key while clicking on
individual planning units. If you wish to start over, go to the Theme menu and select the ‘Clear
Selected Features’ option. Alternatively, you can use the ‘Clear Selected Features’ tool on the
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toolbar. Then you may begin selecting units again. Note that planning units will be selected if
the rectangle intersects any part of the unit, not just those that are completely contained in the
rectangle.

=] The ArcView ‘Select features’ tool.

At any time, you can check on the current cost of the selected planning units by clicking on the
‘$” icon on the button bar (see Section 4). This computes the appropriate costs (for land or
easement purchase or incentive offer as appropriate) of all selected units. This informs you of
whether you have already exceeded your budget or can select additional units.

It is relatively easy to forget to use the Shift key to add planning units to the set you previously
selected. This has the effect of unselecting those and only selecting the new units. To guard
against this accidental loss of your work, TAMARIN provides a means of saving what you have
selected in a file, and in case of accidental loss, of recovering what you had selected. The
Paper Clip button saves your current selection (writes it to the savepu.dbf table). The Redo
button to the right of the Paper Clip uses that table to select the units that you had saved (see
Section 4).

= i Select by Query—
#! Cell990m.sh — O] % - .
= gttt =10] x| ArcView has built-
Fields Walues in procedures for

[Land_walue] :I ‘;’
[Eazement_Yalue1]
[Eazement_YalueZ2]
[E azement_* alus3] =

[E azement_* alusd] ‘_,
[Uzer_Defined_E azer
[Fe-Establizhment Co ;I

- querying the

attributes of the GIS
=

database and

not selecting those

- planning units that

match the Boolean
search criteria. For

[ [Ffor_ha] »= 30) and [[E azement_Yalued] < 20000 “ Mew Sot I instance, in a query
of planning units
Add To Set | with at least 30 ha
of mature forest
v | SelectFram Set | AND an easement

value less than
20,000 reais per
planning unit, those units that satisfy both conditions would be selected. Select the ‘Select by
query’ option in the ‘Selection Options’ menu. This will open a dialog window in which you can
specify the selection criteria. The list on the left side of the dialog box contains the set of
attributes for the planning units. For our example above, you would double-click on the
‘Pfor_ha’ attribute, which would then appear in the query window in the bottom of the dialog box.
Next, single click on the *>=" operator symbol in the middle of the dialog box. Then type the
number ‘30’ in the query window. To add the second criterion, single click the ‘AND’ symbol in
the middle of the dialog box. Next, double-click on the ‘Easement_Value4’ attribute in the left
window, followed by the ‘<’ symbol. Type ‘20000’ (no commas) in the query window and click
on the ‘New Set’ button. Use the ‘New Set’ button if these are the first units you are selecting
for this scenario. You could now add additional units with another query if you wish. For
instance, you may wish to add units where tree-shaded cocoa is at least 30 ha and the same
easement value limit. Select the text in the lower window and press the backspace key to
delete it. Make another query, but this time, press the ‘Add to Set’ button. Now you can refine
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your selection by adding another criterion. For instance, you may only wish to select units from
your previous selection that are not densely populated. Clear the query in the lower window
again and put in your new query, e.g., [Population] < 15. ‘Select From Set’ will then only select
a subset of planning units that satisfy the current query from the set that was previously
selected. You can also use the graphical selection tool to further refine your choice by adding
or removing individual planning units from the selected set. (DO NOT USE THE ‘Selection
Options’ MENU AGAIN, HOWEVER, OR THE PREVIOUSLY SELECTED UNITS WILL BE
UNSELECTED).

Select by Theme—If a stakeholder has already created an ArcView shapefile that represents a
conservation scenario, you may use that shapefile to select planning units for evaluation. Select
the ‘Select by theme’ option in the ‘Selection Options’ menu. You will be prompted to identify
the shapefile in a browser dialog. Navigate to the shapefile’s folder (the browser will begin in
the current working directory), select it, and click the ‘OK’ button. This theme will be added to
the Analysis View window and will be overlain on the planning unit theme. Planning units that
are completely contained within the areas in the shapefile will be selected. (Currently no option
is provided for other intersection options, e.g., ‘Intersects’ that selects if any part of the planning
unit is within the shapefile area.) You can also use the graphical selection tool to add or remove
individual planning units from the selected set. (DO NOT USE THE ‘Selection Options’ MENU
AGAIN, HOWEVER, OR THE PREVIOUSLY SELECTED UNITS WILL BE UNSELECTED).
This selection option would also be useful to refine a scenario that you have previously
evaluated. Use the shapefile produced for the earlier scenario as the theme to select by, then
modify the selection by further adding or selecting from the initial set.

5.1.3 Constrain by Budget

&%
>

Tam.CountCosts x |

-
-0

To this point, the planner has
selected planning units based on
Total Land Yalue of Selected Planning Units: their attributes without regard to
Fi3178.245 636 the total cost. It is possible that
the total cost of the initial scenario
exceeds the budget specified in
the scenario definition step
(Section 5.1.1). ltis possible at
this point to check the total cost,
based on the selected payment method, by clicking on the $ tool, which displays the sum in a
message box as shown here. Selecting the ‘Constrain by Budget’ menu, TAMARIN checks if a
budget limit was set. If not, it gives you an opportunity to add one. If you did set a budget limit,
the planning units are sorted either by costs (land value or easement value attribute as
appropriate) in ascending order or by your preferred environmental benefits index in descending
order and sums the appropriate costs (land value, easement value, or incentive offers) until the
budget constraint is reached. Thus the procedure selects either the least expensive planning
units or those with the greatest relative suitability for restoration or conservation for the given
budget. The choice of which cost to use is based on your selection of whether to purchase land
or easements or pay incentives in defining the scenario (Section 5.1.1). Planning units are then
selected from your initial set until the budget is exhausted. After running this step, a new
shapefile named after the scenario name will be created and added to the Analysis View. This
shapefile will only contain the selected planning units that do not violate the budget constraint
and is used in the evaluation procedures described in Section 5.2.
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F,;-' Sort Choice x |

Choose item ta sort by Ok

| Costs LI Cancel

Environmental Benefits

TAMARIN reports the reduction in the number of planning units as a result of imposing the
budget constraint.

-‘f_:-’ Budget constraink results--SortPoly x |

selected

O The budget constraint reduced the number of
planning units fram 7028 to 1203

Note: When choosing to sort by Environmental Benefits, TAMARIN will automatically select the
cheapest planning units with the highest EBI values. However, when sorting by Cost TAMARIN
will select planning units with low total cost. Because the land value recorded in a given
planning unit only totals the land values of categories suitable for supporting forest growth,
planning units located on the boundary of the study area, containing water or no data, or
planning units with urban areas even if the per hectare price is high could be in the selection.
Choosing an EBI normalized by land value (e.q., EBI 5 per LV) eliminates this problem.

5.1.4 Cautionary note on selection and sorting of planning units

The variation in area among planning units (as described in Section 3.1) has consequences
when sorting planning units under a budget constraint, or when selecting units by query.
Because the planning units are artificial constructions, it is probably most logical to sort them or
select them according to per-hectare characteristics. In general, the EBI variants (including EBI
adjusted by land value) are defined on a per-hectare basis or a proportional basis. This is also
true for variables which describe the proportion of the planning unit under specific types of
forest: ‘propprimfo’, ‘propsecfor’ and ‘propcab’. However, the costs, easement values, and the
other land cover variables are defined in absolute terms (for details on all variables see
Appendix E).

Consider, then, selecting planning units by query. To preselect planning units with per hectare
land values less than R$100, one would specify:

[Land_Value] < 100 * [Hectares]
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If one used:
[Land_Value] < 9801

the results would include some small planning units, but possibly with high per-hectare land
values — e.g., a 10 hectare planning unit with per-hectare value of R$900.

Similarly, consider sorting planning units under a budget constraint. If the user decides to sort
by EBI, TAMARIN will sort by the per hectare EBI. The result of this procedure is that
TAMARIN selects the highest ranking units with the highest EBI values per hectare (including
EBI adjusted by land value), regardless of the sizes of the planning units. However, when
sorting by cost using land value (or easement value), TAMARIN bases its analysis on the cost
of the entire planning unit. This may lead to unexpected results. However, exclusion of "small"
planning units may also be unsatisfactory. Some of the "small" planning units may be located
on the border of protected areas and hence would be preferred sites for selection into a
conservation set.

5.2 Evaluation Procedures

Evaluation SEIEIEEGERE =1 Hele Once the scenario parameters have been defined and the set
Eorecast Future Land Lze of planning units has been selected, the next group of
iR procedures perform the evaluation of the scenario, including

the forecast of future land cover/use (Section 5.2.1); a
summary of the economic and environmental effects (Section
Etint ap af Fragments 5.2.2); a series of landscape indices characterizing the
e resulting landscape configuration relative to the conservation
objectives (Section 5.2.3); and preparing and printing a
summary map the scenario (Section 5.2.4).

Landzzape Configuration

Show a Scenario Lestflile...

5.2.1 Forecast Future Land Use

This analysis step combines the data from two grids to create a future land use forecast for the
scenario. The two grids are: 1) the restoration theme for selected planning units, and 2) the
business-as-usual scenario for the remaining lands. TAMARIN merges those two grids to
create a future land use forecast grid that is added to the Analysis View window.

Here is the processing logic used to create the theme of future land use:

Was the planning unit selected?
If yes 2 Restore option as described in section 3.3 (or your own version)
If no 2 BAU as described in section 3.2 (or your own version)

This theme is given the name of the scenario that you entered in the opening dialog. The
legend is very similar to the Land cover theme, except 1) the other forested media (e.g., tree-
shaded cocoa in Bahia) and bare land classes are not used (they either become restored forest,
secondary forest or agriculture/pasture land depending on the scenario), and 2) a restored
forest class is added. Simply select the ‘Forecast Future Land Use’ option from the ‘Evaluation’
menu. This newly created grid is used in the remaining evaluation steps.
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5.2.2 Summarize Scenario Solution

It is not enough to make a map of future land use, it is also necessary to derive some summary
measures about it that can be compared to other scenarios, to the current land use, to the
business-as-usual scenario, and to the conservation objectives. Simply select the ‘Summarize
Scenario Solution’ option from the ‘Evaluation’ menu. TAMARIN computes the summaries and
prints them to a series of tables and/or to a text file. In all the summary tables, the scenario
being evaluated is highlighted in yellow and “promoted” to the top row of the table. The first
table summarizes total scenario cost. Even though you specified whether to pay land or
easement value or an incentive offer, the summary table lists totals for all three types plus the
amount needed for forest reestablishment costs in units beyond the seed range from existing
forest. The easement value total is based on your choice of assumption about easement
values/opportunity costs in the ‘Define a scenario’ step. The second table lists the percent of
land use/cover type in the scenario for the types that can change between scenarios. For Bahia
the mangrove, wetlands, caatinga, restinga, water, urban, and eucalyptus types are not shown
since they are assumed to remain constant in all scenarios. Therefore, the percentages of land
use/cover types listed in the table will not sum to 100%. The third summary table gives a similar
breakdown of land use/cover types inside the Area of Special Interest (AOSI) only when the
AOQOSI grid is located the Working View. The scenario text file gives additional summary values
such as the average/maximum/minimum of the Environmental Benefits Index (again based on
your choice of index), minimum and maximum land and easement values, the number of units
selected (and that do not exceed the budget), the net change in area and percent change in
land use types from the current land cover, and the regional breakdown of cover types in
percentages.

Summary tables with the scenario being evaluated highlighted in yellow

71 Costs by Scenario IM[ulE3|| " Scenario Cost
Srananin| Landvabe | Eavamantsabes | dncedie e Faenisbishman | Frescost Costs by Scenario
$EOmil | B9995702.3! 23164364.9 noi 1932400 997924359 ;l "EEEEEEEE
i lninininieiyl
ol 0
1 [

71| Land Use by Scenario [=] E3 |§ < Land Use =] ES
Soaazei|  Fmapdhes | Sestveadfras || Sacoadlsyfoesd | Sabwens | Amindeshasins Land Use by Scenario

$EOmil 91 5291 44; 0.0¢ 261~ EH
An
an B $60mil
E I 5
11
1]

: Land Use in Area of Special Interest by Scenario il | 41 Land use in A0SI !E[ E3
Sraaasn | Fhmancdnert | Sesteddiest | Seeoache ey | Satvas | dawmaliesshaeiine Land Use in Area of Special Interest
$EOmil 17! B35! 11.0¢ 0.0¢ 17.8 ;l gg
an
anE I
in
= |
4| D

30



5.2.3 Landscape Configuration

The desired future landscape configuration is defined not just to achieve a target area of mature
and restored forest in the Corridor but to do so in a number of relatively large, contiguous blocks
of forest habitat with a large proportion in core or interior forest and a small amount of edge.
The ‘Landscape Configuration option on the ‘Evaluation’ menu computes a number of
landscape indices, including the size of the largest forest fragment, the total area of mature and
restored forest, the number of forest fragments, the frequency of size classes of fragments (0-
200 ha, 200-500 ha, 500-1,000 ha, 1,000-2,000 ha, 2,000-4,000 ha, 4,000-6,000 ha, 6,000-
8,000 ha, 8,000-10,000 ha, and > 10,000 ha), the number of fragments that are larger than the
minimum habitat size specified in the opening dialog (Section 5.1.1), and the area and
percentage of forest that is in core versus edge habitat. These results are written to a set of
tables and/or to the scenario text file.

Example of summary tables in Landscape Configuration analysis

2 Fragment Size Frequency by Scenario
Soyada] o SEETAS| SRESRTAR | SRR A NIRRT 3| SRRRESRRT A SERRASIART A3 SIRRESRRT A SEAREFRRRT AL 2 AR
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The ‘Landscape Configuration’ option processes the following steps (see graphics below for an
illustration):

1.

Extract the forest pixels from the Future land use theme for the scenario (mature and
restored forest only)

Expand from this set of pixels by half the gap-crossing distance (to determine which
patches are functionally linked)

Mask out paved road/urban corridors as barriers to clustering pixels into habitat blocks
Use the RegionGroup command to aggregate pixels from #2 into clusters

Extract forest pixels in #3 by cluster, giving them unique numbers for each fragment and
assess size-frequency (theme added to Analysis View, colored by the size of fragments)

Expand agricultural and urban land use pixels by the edge distance into fragments to
identify edge vs. core pixels. Forest adjacent to mangroves, wetlands, other native
habitats, or secondary forest and eucalyptus plantations are not considered edge. That
is, we are only concerned with anthropogenic edges here (theme added to Analysis
View, colored by edge pixels (pink), mature forest (dark green), and restored forest
(bright green)

Select fragments from step #5 that exceed the minimum viable habitat unit size (theme
added to Analysis View, colored by unique ID number of the habitat unit), and determine
largest fragment size

Summarize number of these fragments in each bioregion (not shown)

Summarize number of these fragments that have more than 1000 ha of mature forest
(not shown)
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Example of processing steps in Landscape Configuration analysis

Scenario future land use

Step 1-Extract forest pixels

Step 2-Pixels within gap-
crossing distance (shades
of red)

Step 3-Mask out paved
roads (black lines)

Step 4- Regiongroup of
clusters of contiguous
pixels within gap-crossing
distance

Step 5- Extract forest
fragments from clusters

Step 6- Core (green)
versus edge (pink) pixels
adjacent to agriculture and
urban pixels

Step 7-Select viable
habitat units (greater than
10,000 hectares in size)

5.2.4 Print Map of Fragments

This option compiles the maps from the evaluation of the scenario and organizes it into a
printable page using ArcView’s built-in layout functions. The script assembles a layout
document that contains an 8.5 x 11 inch map of the forest fragments larger than the minimum
size. The report page is automatically formatted for you when you select the ‘Print map of
fragments’ menu option. You can then use the ‘File>Print’ menu to send the page to a printer
or print it to a file or the ‘File>Export’ menu to export the layout to a graphic format.
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Example of a printout map
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5.3 Scenario Outputs

TAMARIN creates several different types of outputs. One output is a text file containing the

basic information about the scenario. It also generates a future land use grid with the name of
the scenario, as described in Section 5.2.1.
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5.3.1 Scenario Text File

The scenario text file contains a description of the scenario (e.g., name, date, business-as-usual
and restore scenario names, budget constraint, minimum habitat unit size, etc.). This file is
created when you select a scenario name in the opening dialog for defining the scenario. Itis
given the name <name>_scenario.txt where <name> is the name you assigned in the dialog.
For example, a scenario textfile contains the following:




There are two options for viewing scenario text files under the ‘Evaluation’ menu. The ‘Show
current scenario textfile’ opens a text window with the results for the scenario you named in the
latest Scenario Dialog. If you would like to view text files from other scenarios for comparison,
choose the ‘Show a scenario textfile’ option. This will prompt you for the name of a textfile from
a list of all such files in the current working directory. Select a filename from the list and click
the ‘OK’ button. A window will open on the screen. Click the ‘X’ box in the upper right corner to
close the window.




5.3.2 Future Land Use Scenario Grid

For each scenario, a new ARC/INFO grid is created showing the land cover/use that is forecast
based on the selected planning units, their specified conservation intervention, and the
business-as-usual scenario for unselected units. This grid is given the name of the scenario
and is saved permanently. Other themes may be created in the analysis procedures, but these
are temporary files that are not automatically saved. If you look in the ‘Theme - Properties...’
menu, you will see these grids described as ‘Temporary’. Once you exit from TAMARIN, these
themes will be deleted from memory unless you explicitly save them. To save them
permanently, make the theme active, go to the “‘Theme’ menu, and select ‘Save data set...".

You will be asked for a filename for this theme. The themes properties will now identify this as a
‘Permanent’ theme.

These grids will be automatically saved if you save the project file (under ‘File > Save...’, or
clicking the ‘save’ icon). In this case, however, the files are given their temporary names, such
as GRID33, RCLSS4, and similar uninformative names. Therefore, it is recommended that you
explicitly save them with meaningful names if you wish to keep them.

5.4 File Management

File M anagermet Help TAMARIN may create a large number of
Delete Temporary Grids... temporary grids and shapefiles. Two useful utility
programs were provided under ‘File Management’

Delete Temporary Shapefiles... ) i
for a simple deletion of unnecessary themes from

Lieate New FU Theme.. the TAMARIN folder. If you need assistance
Calculate Land Cover Froportions in PL Theme.. updating the planning unit theme with new data or
&djust Yalues Inside Reserves in PU Theme... creating a new one in order to migrate TAMARIN
Impute Land alue in P Theme. .. into a different region, use the wizard-type

Caleulste BBl Maliesin PU Theme - programs listed below; they will automate the task

for you (see also Appendix B for step-by-step
description of processing required for creation of a
EBopulate Field in P Theme... new planning unit theme).

Adjust Values Inzide Bolugonz in PU Theme...

Set Aliazes to Eieldz in PU Theme. ..

Calculate Easement Yalues in P Theme. ..

5.4.1 Deleting Temporary Grids and Shapefiles

The first two options under this menu will help you to delete unwanted grids and shapefiles.
They work in essentially the same way except that they only list the files of the appropriate type
to be deleted. Click on one of the options. TAMARIN opens a dialog window that lists the
themes (grids or shapefiles) in the root folder. You can navigate to a different folder if desired.
To delete old themes, click on its name and then the ‘Delete’ button. The theme cannot be
deleted if it is currently being used in TAMARIN, such as being displayed in a view or as a table.
In such cases, click ‘Cancel’, delete the themes and tables from the TAMARIN project, save it
again, and then try deleting the themes through the ‘File management’ menu.

5.4.2 Creating a New “Empty” Planning Unit Theme
The first of the eight utilities was designed to automate creation of a new planning unit theme.
This utility creates a rectangular grid of planning unit cells with associated empty database fields

as described in Appendix E. It has an ability to restrict TAMARIN analysis to a desired area of
interest by allowing a user to utilize either a polygon or a grid theme for this delineation. After
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starting the utility ‘File Management->Create New PU Theme’, a series of self-explaining
dialogs will ask you to provide a name for the new planning unit theme, a size for the planning
unit (in meters) and finally, a type and source name for the delineating theme. Once satisfied it
will create an empty planning unit theme ready to be populated with data.

5.4.3 Calculation of Land Cover Area per Planning Unit

The second utility program calculates the number of hectares of each land cover class present
within a planning unit and writes the resulting values into appropriate fields within a planning unit
theme table e.g., Pfor_ha, Sfor_ha, Cab_ha (see Appendix E for a full list). It also calculates an
area that contains every type of land cover with the exception of urban areas, water, no data
(i.e., Nourbwat_ha). Similarly as for the previously described utilities, run the program from the
‘File Management’ menu and follow the series of input/output dialogs.

5.4.4 Adjusting Values Inside Protected Areas Polygons

The third utility program sets the Nourbwat_ha and Hectares attributes to zero for planning units
located inside polygons delineating existing protected areas. It also adjusts values of the above
listed variables to reflect different areas in ‘slivers’—arbitrary polygons outside of protected
areas created when polygons representing existing protected areas intersect with polygons of
planning units. This step is necessary to reflect zero cost for area of existing protected areas.
Similarly as for the previously described utilities, run the program from the ‘File Management’
menu and follow the series of input/output dialogs.

5.4.5 Imputing Land Values in Planning Unit Theme

This program was designated to impute land values using existing attributes of the PU theme
and regression coefficients obtained from multivariable model of land values (Chomitz et al.
2004). The imputed values are written into attribute called Land_value within the planning unit
theme. After starting the utility ‘File Management->Impute Land Values in PU Theme...” a
series of dialogues will guide you through the selection of a planning unit theme and the
previously derived regression coefficients. If the spatial distribution of land values is available
as a grid theme use the ‘File Management->Populate Field in PU Theme...’ utility instead (see
Section 5.4.8 for details).

5.4.6 Calculation of Environment Benefit Index Values

Within a planning unit theme table, this utility calculates EBI values as they were defined in
Section 3.1, i.e., EBI_Orig, EBI_Cab, EBI_Pref, EBI_5, EBI_Pref per LV, EBI 5 per LV, and
EBI_Core_per_LV. To be able to obtain the latter three indices, Land_value and EBI_Core
attributes need to be calculated prior to running this program (see Appendix E for attributes
description). Similarly as for the previously described utilities, run the program from the ‘File
Management’ menu and follow the series of input/output dialogs.

5.4.7 Calculation of Easement Values

Within a planning unit theme table, this utility calculates four Easement Values as defined in
Section 3.1 and stores the results in variables EaseVal1, EaseVal2, EaseVal3, EaseVal4
respectively. Knowledge of regression coefficients used for imputing land values is required
prior to running this program. These coefficients were predefined within this utility according to
the results of multivariate regression analysis for deriving land values (Appendix D). Similarly
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as for the previously described utilities, run the program from the ‘File Management’ menu and
follow the series of input/output dialogs.

5.4.8 Populating Planning Unit Theme

This utility program was designed to extract values from an arbitrary grid using a planning unit
theme. The extracted values are subsequently written into a specified field within the planning
unit theme. After starting the utility ‘File Management->Populate Filed in PU Theme...’ a series
of dialogues will guide you through the selection of: a planning unit theme, a grid, a reference ID
field and an output field. Use the utility program with caution. The program has the ability to
overwrite existing values.

5.4.9 Adjusting Values Inside Arbitrary Polygons

Contrary to the previously described utility this program adds/subtracts an arbitrary land value
(price per hectare) to or from the existing land values and adjusts all other associated variables
(listed in the previous utility) inside arbitrary polygons defined by an input theme. This utility is
particularly useful for updating a planning unit theme when the market value of land changes or
if other previously hidden costs are associated with certain tracks of land with known
boundaries. Similarly as for the previously described utilities, run the program from the ‘File
Management’ menu and follow the series of input/output dialogs.

5.4.10 Restore Field Aliases in Planning Unit Theme

Occasionally after copying a planning unit to or from a different location the associated aliases,
describing the individual fields using longer strings then 10 characters area, are lost. This utility
restores the original aliases as described in Appendix E. Similarly as for the previously
described utilities, run the program from the ‘File Management’ menu. Note: Errors will be
generated if the aliases are not correctly set.

5.5 Running Batch Processing and Multiple Batch Processing

The time required for processing TAMARIN scenarios was found to be dependent on several
factors. Namely it depended on the size of a data set, CPU speed, the number of planning units
selected for the analysis, and, to a lesser degree, also on the amount of available RAM. The
sorting of planning units, summary calculations and in particular landscape configuration
calculations, took the longest time. In general while working with small subsets of data (circa 80
x 80 km in size) the processing time when using 1-2 GHz processors was not an issue and
could be done interactively following processing steps as described previously in this section.
However, conducting analysis on a regional scale for multiple scenarios using an interactive
mode was found to be impractical. For this reason, single and multiple batch processing
functions were added to TAMARIN.

5.5.1 Single Batch Processing

The Single Batch Processing function was designed to emulate the interactive processing steps
as described previously in this section. Prior to processing, input parameters must be changed
in the predefined text file located in the current TAMARIN directory. Using a text editor, open
input parameters query.txt or input parameters theme.txt file and enter the desired
parameters. Each line in a text file represents a single parameter entry made during the
interactive session (Appendix F). The first file was predefined to select planning units using a
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specific query, and the second one, using a specific theme. Run the program by ‘Select
Sites>Single Batch Processing...’, select desired input parameters file and press the ‘OK’
button.

5.5.2 Multiple Batch Processing

Similarly as for the Single Batch Processing, change parameters in the predefined input
parameters query multiple.txt file, located in the current TAMARIN directory, to desired
values prior to execution of the program. Please note that the three initial parameters (line 1 to
3) differ from the Single Batch Processing parameters file and from the processing flow as
described previously in this section (Appendix F). The parameters represent, respectively: 1) a
starting budget, 2) an ending budget and 3) an incremental budget. It is advisable to choose
these lines with caution; a simple error can lead to TAMARIN computing an undesirably large
number of scenarios.
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6. CREATING A SCENARIO—AN EXAMPLE

In this section, we illustrate the process for creating and evaluating a hypothetical scenario,
following the steps described in Section 5. The example scenario is based on an economic
incentive, where we assume a flat price offer is made rather than paying fair market easement
value, and seeing which landowners are likely to accept it.

Let us assume some purchasing authority offers to pay environmental compensation for
properties with specified characteristics or within specified zones. Let us further assume that
the authority has a fixed budget. The authority publishes a formula that assigns an
environmental benefit index (EBI) to each candidate unit. We cannot predict which landowners
will choose to participate so let us simply say that any eligible units can be selected if the
offered price is at least as high as the opportunity costs as estimated in the easement values.
The authority ranks planning units by EBI and purchases from highest EBI to lowest until the
budget is exhausted. How can this policy be demonstrated in TAMARIN?

Begin by defining the scenario and set the budget to R$30,000,000. In the second dialog box,
select the ‘Pay other incentive offer’ radio button. We will accept the defaults for the desired
landscape configuration. We select the ‘EBI_Core’ benefits index option and set the incentive
payment offer at R$200 per ha. To identify eligible units, we use the ‘Select by Query’ menu
option. We first query for units that are restorable without paying reestablishment costs
([Restorable] = “y”) and ‘Select from Set’. Existing reserves are already protected so we can
exclude them from the candidate set by querying ([InReserve] = “n”) and ‘Select from Set’. We
next select planning units outside the coastal bioregion where mature forest is not an issue.
([Bioregion_Name] <> "Coast/Wetland/River"). To identify potential sellers, we must limit the
units to those whose opportunity costs are less than R$200 per ha, so we query for
([Easement_Value4] <= 19602) (i.e., R$200/ha * 98.01 ha/unit = R$19,602/unit) and ‘Select
from Set’. This leaves us with 19,275 units out of 77,010 total and a cost of R$364 million if we
pay R$200/ha. In contrast, if the authority were only paying the estimated easement value (#4),
the total cost would be R$233 million. This still far exceeds the budget so we further reduce the
set of units by applying the ‘Constrain by Budget’ menu option. We elect to sort by the
environmental benefits index (EBI_Core) in descending order and allocate funds until the
budget is exhausted. This reduces the selected set to 1,539 units. The scenario summary
indicates that these units could actually be purchased for only R$36 million and the easement
value is only R$5 million. Thus there is a high cost of a flat incentive payment compared to
other incentive mechanisms. This instrument, however, only achieves the conservation
objectives in two of the seven bioregions, because the selection process chooses many
relatively small, isolated fragments. Further refinement would be necessary to produce the
desired clumping of fragments.
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7. DATABASE REVISIONS OR SUBSTITUTIONS

The TAMARIN planning support system, based on ArcView and customized with AVENUE
scripts, was originally designed specifically for corridor planning in south Bahia, Brazil, and to
address specific research questions of interest to the research team. As a result, the GIS data
and AVENUE coding are tightly coupled. It is highly likely that some of the themes will be
updated during the remainder of the planning process. Therefore, there may be a need to
replace or update themes or attribute data in TAMARIN. This section describes how to do so.
Others may wish to adapt TAMARIN for other corridor projects in other regions of the world.
TAMARIN will require some modifications. The second part of this section outlines some of the
general changes in data and in the coding of AVENUE scripts themselves to be used in corridor
applications in other parts of the world.

7.1 Updating Bahia Data

TAMARIN was developed with the GIS database that existed at the time. Some of the data
layers were draft versions or needed some fine-tuning before final analysis. At least four types
of revisions may be involved if revised themes are produced in the future: 1) substitution of a
newer version of a theme (e.g., a land cover theme that fills in cover types where clouds
obscured the ground in the initial version), 2) substitution of a new value for an attribute (e.g.,
revised model results for predicted land value), 3) replacement of derived GIS themes as a
result of revision in the primary data layer (e.g., updating the business-as-usual scenario which
was derived from the land cover theme), and 4) creating new themes as alternatives (e.g.,
creating your own business-as-usual scenario based on different assumptions about the future).

The safest method to replace a new version of a theme is to delete the Bahia themes in the
TAMARIN view windows. Make a theme active by clicking on its legend in the table of contents.
Delete by using the ‘Edit->Delete’ menu. Save the project file and then delete (or rename) the
original theme from the folder by using the ‘File Management’ menu as described above or by
using ARC/INFO commands. Also using the file management dialog, copy the new version to
the folder and give it the same name as the original version. Then use the ‘View->Add Theme’
menu to add the new version to the appropriate view. While it is also possible to simply swap in
the new version in the folder while TAMARIN is closed, so that the new version will be used the
next time TAMARIN is run, this will be risky if the attribute table is slightly different.

In some cases, it may not be the whole theme that has been revised but only one or more
attributes of a theme. The most likely example would be a revised prediction of land values or
opportunity costs, as a result of more data points in the sample, additions to or changes in the
independent variables, or improved regression modeling. The output may be a text or dBase
format file with columns for the ID number of the planning unit and for the new values. Add the
table to TAMARIN and proceed to Join the table to the Attributes table of the planning unit
theme by the unit ID number. Use the ‘Fields->Calculate’ menu and calculate the attribute
fields with the value in the new table. The original values in the fields can also be overwritten by
the file utility program ‘Populate Field in PU Theme’ located under the ‘File Management’ menu
described in Section 5.4.3 of this manual.

As noted in Section 3, some data layers are derived from the primary themes. Updating a
primary theme also requires updating the derived themes. In the case of revisions to the Land
cover theme, it will be necessary to reproduce the business-as-usual and restoration themes
based on the lookup table shown in Section 3.3 or using an alternative model. The old themes
must then be deleted from TAMARIN'’s views and from the folder, just as the primary theme was
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in the preceding paragraphs. The new themes must be added to the Working View. In the
Legend Editor, Load the restore.avl lookup table to color the cover classes. Do not change the
theme name in the Table of Contents of the view because TAMARIN expects to find it with that
name.

You may wish to make different assumptions about future land use or restoration opportunities
than those made in the original version. Simply generate a new theme, give it a meaningful
name, and save it in the appropriate folder (in the case of business-as-usual and restoration
themes, this should be in the Options folder). Make sure the theme has the same projection
parameters as described in Section 3. When you run TAMARIN to create a new scenario, you
can specify your new themes as part of the opening dialog for ‘Define a scenario’. Likewise,
you may substitute a different planning unit theme based on other kinds of spatial units, such as
census tracts or squares of a different resolution. A set of utility programs provided under the
‘File Management’ menu and described in Section 5.4 were specifically designed to accomplish
this task. A detailed list of steps necessary for creating a new planning unit is included in
Appendix B.

7.2 Modifications for Other Corridor Projects

Conservation planning for the Central Atlantic Forest Corridor in southern Bahia was based
primarily on meeting broad conservation objectives (i.e., representation, redundancy, and
resilience) in the most economically efficient manner possible. The Corridor has been severely
deforested, with only about 5% on the region remaining in primary forest, mostly in small
fragments. The focus in this project was to decide on the best combination of protecting
remaining fragments and restoring forest to expand, connect, or complement those fragments.
TAMARIN may not be particularly useful in planning efforts where the conservation issues are
significantly different than this. For instance, TAMARIN would not be useful where the objective
was to represent many different habitat types to some specified level. In that case, a decision
support system such as Sites 1.0 (Andelman et al. 1999) might be more appropriate (see
http://www.biogeog.ucsb.edu/projects/tnc/toolbox.html).

If TAMARIN is suitable for use in a given corridor study, the themes for the new corridor must
correspond exactly to those for Bahia. The required GIS themes described in Section 3 are
used in the analysis procedures in TAMARIN. In addition, they are generally referenced by
their name in the view table of contents, so they must be given the same names in other
applications. Furthermore, the attributes of the themes, particularly for the planning units
theme, must exactly match those in the Bahia project, both in field name and its definition (e.g.
width, type, decimal places). Itis recommended that the themes be placed in the same folders
as their counterparts in the Bahia project. To do this, first delete the Bahia themes in the
TAMARIN view windows. Make a theme active by clicking on its legend in the Table of
Contents. Delete by using the ‘Edit->Delete’ menu. Save the project file and then delete the
Bahia themes from the folder by using the ‘File Management’ menu as described above or by
using ARC/INFO commands. If you do not remove a theme from the project and save the
project, the file manager will think the theme files are being used by an application and refuse to
let you delete them. Insert your own themes in the same folder, either with the same file
management dialog or with ARC/INFO commands.

The other issue in adapting TAMARIN to other areas is that some of the scripting is hard-coded.
In particular, the Summary Statistics and the Landscape Configuration scripts use specific class
values from the Land cover, Business-as-usual and Restoration themes. A user has two
choices: 1) either to reclassify his/her themes so they match exactly the class values of the
themes developed for Bahia (names of the classes may be different) or 2) modify the scripts to
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match the different class values (recommended only for experienced Avenue developer). A
“wizard-like” script that will have the above-described functionalities is under development. A
step-by-step guide for creating and customizing Cell990m planning unit theme could be found in
Appendix C.

Contact Miroslav Honzak at Cl (mhonzak@conservation.org) or David Stoms at UCSB
(stoms@bren.ucsb.edu) to discuss whether TAMARIN would be appropriate for your application
and how to modify it. To obtain more information, the latest version of this manual and
TAMARIN code visit http://www.tamarinmodel.org/ website.
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APPENDIX A: TAMARIN ScRIPTS ACTIVATED DURING SCENARIO EVALUATION PROCEDURE

The following table lists the AVENUE scripts and dialogs (in italics) in TAMARIN that relate to
the steps in the flowchart in Section 1.2.

1. Define scenario objectives
Tam.openScenarioDialog
Tam.ScenarioParams
Tam.openScenarioDialog2
Tam.ScenarioParams?2
Tam.acceptScenarioParams
Tam.PickPUTheme
Tam.PickBAU
Tam.PickRestore
Tam.PickEasementValue
Tam.PickEBI

2. Select planning units (and constrain by budget)
e Tam.chooseSiteSelector
e Tam.CompPoly or Tam.SortPoly
e Tam.gsort

3. Project future land use/cover
¢ Tam.FutureScenario

4. Evaluate socioeconomic and landscape impacts
Tam.SummarizeSolution

Tam.PAsizeStats

Tam.LandMetrics

Tam.PatchSizeFreq

Tam.PatchSizeBioreg

Tam.PatchViableBioreg

Tam.PatchSizeStats

Tam.PatchSizeCost

5. Printing a map layout
e Tam.MapLayout
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APPENDIX B: STEPS TO BuiLD NEW TAMARIN PROJECT USING TAMARIN EXTENSION AND
FILE MANAGEMENT PROGRAMS

A set of file management “wizard-like” programs was developed to assist users in building a
new TAMARIN project. Function and usage of these programs is described in Section 5.4. The
following processing steps must be executed in the particular sequence as presented below.

1. Load TAMARIN extension (see Section 2.2), or alternatively, open tamarinnew.apr
(ArcView project file located in tamext directory)

2. Add ‘(+) the following themes to the Analysis View

Bioregions (required grid, see Section 3.4 for details)

Landcover (required grid, see Section 3.7 for details)

Existing Reserves (optional shapefile, see Section 3.8 for details)
Roads (optional shapefile)

Cities (optional shapefile)

Bioregions Outline (optional shapefile)

Provinces (optional shapefile)

@ "0 oooToD

3. Add ‘(+) the following themes to the Working View

AOI area of interest layer (required grid)

Paved Road Mask (required grid, see Section 3.6 and Appendix B for details)
Existing Reserves (optional shapefile, see Section 3.8 for details)
Landcover (required grid, see Section 3.7 for details)

AOI area of interest layer (optional shapefile)

Bioregion ID (optional grid)

Population (optional grid)

EBI core (optional grid)

AOSI area of special interest layer (optional grid)

T T@mooo0UT

4. Activate Working View, follow with 'File Management—->Create New PU Theme...’

a. Create a new planning unit (PU) shapefile in the GIS_Input directory (e.g.,
Cell990m.shp)

b. Enter size of a planning unit (recommended value is 990 m)

c. Use AOI (a polygon shapefile or a grid) as an input theme

5. Activate Working View, follow with ‘File Management->Calculate Land Cover
Proportions in PU Theme...’

a. Select a PU theme (Cell990m.shp)
b. Select land cover theme (Landcover)

6. Activate Working View, follow with ‘File Management->Adjust Values Inside Reserves
in PU Theme...’
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a.
b.
c.

Select a PU theme (Cell990m.shp)
Select land cover theme (Landcover)
Select existing reserves theme (Existing Reserves)

7. Activate Working View, follow with ‘File Management-> Impute Land Value in PU
Theme...’

=4

Select a PU theme (Cell990m.shp)

Select land cover theme (Landcover)

Enter regression coefficients obtained from multivariable regression model of
land values

8. Activate Working View, follow with ‘File Management->Calculate EBI Values in PU
Theme...’

a.

Select a PU theme (Cell990m.shp)

9. Activate Working View, follow with ‘File Management-> Calculate Easement Values in
PU Theme...

a.
b.

Select a PU theme (Cell990m.shp)
Enter regression coefficients used for calculation of land values

10. Optional transfer of data to individual attributes in a PU theme: Activate Working View,
follow with ‘File Management->Populate Field in PU Theme...’

Qo ow

Select a PU theme (Cell990m.shp)

Select grid theme from which source data should come from

Select an attribute (field) in PU theme to be populated by the data

Repeat for all other required/optional source data (e.g., Land Values, Population,

EBI Core, Bioregion ID)

11. Optional adjustment of land values for extra conservation cost: Activate Working View,
follow with ‘File Management->Adjust Values Inside Polygons in PU Theme...’

a0 ow

Select a PU theme (Cell990m.shp)

Select land cover theme (Landcover)

Select conservation cost polygon theme (Conservation Cost)
Enter regression coefficients used for calculation of land values

12. Add ‘(+) the newly created PU theme (Cell990m.shp) to the Analysis View

13. In the Analysis View set field aliases to Cell990m.shp theme using ‘File
Management->Set Aliases to Fields in PU Theme...’
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APPENDIX C: PROCESSING STEPS USED TO OBTAIN PAVED ROAD MASK THEME

1.

Activate Roads theme in Working View and open table ‘Theme—->Table...’; proceed with
query ‘Table>Query..."” enter ([Tipo2000] = “11”) OR ([Tipo2000] = “12”) AND
([Tipo2000] = “13”) and activate ‘New Set’ to select only paved (main) roads

‘Theme->Create Buffers...” Enter buffer of 200 m, only on selected records, dissolving
barriers. Create new shapefile

‘Theme->Convert to Grid...” add ‘(+)’ grid to the to the Working View

‘Analysis>Map Calculator...’, ([Rd200mbuff] = 200); ‘Theme->Save Dataset...” and call
it rd200mbuff

Make Landcover the active theme. ‘Theme->Table...” select [value] = 14 (urban).
Then, go to ‘Analysis>Find Distance...’

‘Analysis>Reclassify...” convert 0-200 to 1, and all other classes to No Data.
‘Theme—->Save Dataset...” and call it urb200mbuff

‘Analysis>Map Calculator...” and enter the following formula ([rd200mbuff].IsNull +
[urb200mbuff].IsNull)

‘Analysis>Reclassify..." to convert 0 and 1 to No Data, and 2 to 1. ‘Theme—>Save
Dataset...’ call it pvrd_mask

Rename pvrd_mask theme using ‘Theme->Properties...” to Paved Road Mask
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APPENDIX D: NATURAL LOGARITHMS OF LAND SALE PRICE PER HECTARE REGRESSED ON

LAND CHARACTERISTICST

Variable
sale date

agroclimatic index 70-85
agroclimatic index >115
dummy, soil quality=0

soil quality index squared

soil quality index

slope 5-15%

slope 15-25%

slope 25-40%

slope 40-55%
slope 55-70%
slope >70%

dummy, < 5km to coast

km to nearest road

road distance*coastal dummy
proportion of mature forest
proportion of secondary forest
proportion of cabruca or other cocoa

proportion cocoa*climatic dummy

Constant

Note: p-values underneath coefficients, n of observations = 231, r* (adjusted) = 0.274

Coefficient
-.00019472
0.229
-.1280486
0.342
-.43979397
0.001
3.4394615
0.017
-.08062447
0.033
1.1114396
0.018
-.10736309
0.483
-.15907475
0.294
-.27883257
0.070
-.34473497
0.026
-.20097391
0.194
-.43130017
0.131
.90568368
0.002
-.01771909
0.145
-.2321012
0.013
-1.1784783
0.000
-.39720246
0.069
.66136597
0.026
-.76290822
0.018
5.9668794

1 Extracted from Chomitz et al. (2004).
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APPENDIX E: DESCRIPTION OF FIELDS OF THE PLANNING UNITS THEME (CELL990M.SHP)

Field Name Alias Units Meaning Process
Id Plan_Unit-ID None Unique ID number of | Automatically generated by
a planning unit script Tam.WizPUcreator
Hectares Hectares |Area of a planning |Automatically generated by
unit for which land scripts Tam.WizLandcover
value was calculated |and Tam.WizAdjReserves
Land_value Monetary |Total purchase price |Modeled from environmental
unit (USD) |of mature and and spatial variables, see
restorable forest in a | Chomitz et al. (2004) for
planning unit details
Easevall Easement_Value1 Monetary |Total opportunity See Section 3.1 for details
unit (USD) | cost of mature and
restorable forest in a
planning unit
Easeval2 Easement_Value2 Monetary |Total opportunity “
unit (USD) | cost of mature and
restorable forest in a
planning unit
EaseVal3 Easement_Value3 Monetary |Total opportunity :
unit (USD) | cost of mature and
restorable forest in a
planning unit
Easeval4 Easement_Value4 Monetary |Total opportunity “
unit (USD) | cost of mature and
restorable forestin a
planning unit
User_ev User_Defined_Easement|Monetary |Left blank for user to |“
unit (USD) | create their own EV
Reestabcos |Re-establishmentCosts |Monetary |Total cost of If restorable field is Y’ put 0
unit (USD) |restoration in a else if it is ‘N’, invoke cost as
planning unit 2000 * Restore_ha
Inreserve Y/N ‘Y’ if center of planning unit is
in reserve (then set EV and
LV to zero cost); else ‘N’
Population Number of | Density Derived from census tract
people per data
square km
Municipio Name of municipio | Municipio name which
(province) in a intersects with a center of a
planning unit planning unit
Bioreg_id Bioregion_ID N/A Bioregion ID in a Bioregion ID which intersects

planning unit

with a center of a planning
unit
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Bioregname

Bioregion_Name

N/A

Bioregion name in a
planning unit

Bioregion name which
intersects with a center of a
planning unit

Ebi_orig

Index

Original
Environmental
Benefits Index

See Section 3.1 for details

Ebi_cab

Index

Modified
Environmental
Benefits Index that
gives more weight to
tree-shaded cocoa
than EBI_orig

Ebi_pref

Index

Historically preferred
Environmental
Benefits Index

Ebi_pperlv

EBI_Pref _per LV

Index

Ebi_pref adjusted by
land value per
hectare

Ebi_5

Index

Currently preferred
Environmental
Benefits Index

Ebi_5perlv

EBI_5 per LV

Index

Ebi_5 adjusted by
land value per
hectare

Ebi_core

Index

Environmental
Benefits Index
derived using
neighborhood
habitat suitability

Ebi_cperlv

EBI_Core_per LV

Index

Ebi_core adjusted by
land value per
hectare

User_ebi

User_Defined_EBI

Index

Blank EBI user can
create their own EBI

Pfor_ha

Hectares

Area in a planning
unit with mature
forest

Automatically generated by
scripts Tam.WizLandcover
and Tam.WizAdjReserves

Sfor_ha

Hectares

Area in a planning
unit with secondary
forest

Cab_ha

Hectares

Area in a planning
unit with tree-shaded
cocoa plantation

Euc_ha

Hectares

Area in a planning
unit with eucalyptus
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Ag_ha

Hectares

Area in a planning
unit with agriculture

Bare_ha

Hectares

Area in a planning
unit with bare land

Urb_ha

Hectares

Area in planning unit
with urban area

Water_ha

Hectares

Area in planning unit
with water

Wetl_ha

Hectares

Area in planning unit
with wetlands

Mang_ha

Hectares

Area in planning unit
with mangrove

Rasta_ha

Hectares

Area in planning unit
with arboreal
rastinga

Rasth_ha

Hectares

Area in planning unit
with herbaceous
rastinga

Caat_ha

Hectares

Area in planning unit
with caatinga

Nodata_ha

Hectares

Area in planning unit
with no data

Nourbwa_ha

Nourbwat_ha

Hectares

Area of a planning
unit except urban,
water, no data and
area inside existing
protected areas

Restore_ha

Hectares

Area in a planning
unit that can be
restored

Sum of Sfor_ha, Cab_ha,
Ag_ha, and Bare_ha

Restorable

Y/N

Proximity to mature
forest

Y’ if within 1 km of mature
forest, else ‘N’

Agclim

Index

Agroclimatic index
derived from
RADAMBRASIL
maps

see Chomitz et al. (2004) for
details

Declividad

Slope
class

Slope class derived
from
RADAMBRASIL
maps

Km2paved

Kilometers

Distance from paved
roads used to
estimate land and
easement values

Mean of Euclidean distance
from paved roads theme
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Km2coast Kilometers | Distance from Mean of Euclidean distance
coastline used to from coastline derived from
estimate land and corridor boundary
easement values

Cumcost N/A Temporary variable |N/A
used during the
scenario calculation

Cost_add N/A Temporary variable |N/A
used during the
scenario calculation

Dateint Sale date Put constant integer = 14725

Ag200 0M Dummy for Agro- If Agclim is equal to 200 put 1
climatic index

Ag200str 0/1 Dummy for Agro- If Agclim is equal to 200* and
climatic index 0 put1

Dnopedo 0/1 Dummy for soil If Pedology is equal to 0 put 1
quality

Pedolog? Index Soil quality index (Pedology)2
squared

Pedology Index Soils quality index see Chomitz et al. (2004) for
derived from details
RADAMBRASIL
maps

Slope5 0/1 Dummy for slope If Declividad equal to “5-15”
5-15% put 1

Slope15 0/1 Dummy for slope If Declividad equal to “15-25”
15-25% put 1

Slope25 0/1 Dummy for slope If Declividad equal to “25-40”
25-40% put 1

Slope40 0/1 Dummy for slope If Declividad equal to “40-55”
40-55% put 1

Slope55 0/1 Dummy for slope If Declividad equal to “55-70”
55-70% put 1

Slope70 0/1 Dummy for slope If Declividad equal to “>70”
>70% put 1

Dcoastbk 0M Dummy for distance |If Km2coast equal or less
from coast then 5 put 1

Km2roads Kilometers | Distance from all Mean of Euclidean distance
roads from all roads

Km2rdcst Kilometers | Road distances in 5 |Km2roads * Dcoast5k
km proximity to
coast

Propfor12 Proportion | Proportion of a Pfor_ha / Nourbwat_ha

planning unit with
mature forest
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Propcapa Proportion | Proportion of a Sfor_ha / Nourbwat_ha
planning unit with
secondary forest

Prsomcoco Proportion | Proportion of a Cab_ha/ Nourbwat_ha
planning unit with
tree-shaded cocoa

Prsomco_a Proportion | Proportion of a If Ag200 and Ag200str is
planning unit with equal to 0 put Prsomcoco
tree-shaded cocoa if
agro-climatic index is
low

Zcons N/A Constant adjusted 5.9668794 + 0.126052, see
for antilog of Chomitz et al. (2004) for
predicted In values |details
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APPENDIX F: EXAMPLES OF PARAMETER BATCH PROCESSING TEXT FILES

Single batch processing using query to select planning units

$100m

Tamarin
100000000
Comment

10000

500

1000

300

2

Land
Cell990m. shp

bau

restore

EBI_5_ per LV
Select by query
[Bioreg ID] <> 1
Environmental Benefits

Single batch processing using polygon theme to select planning units

$100mt

Tamarin
100000000
Comment

10000

500

1000

300

2

Land
Cell990m. shp
bau

restore
EBI 5 per LV
Select by theme
reserves.shp
Environmental Benefits

Multiple batch processing using query to select planning units

20000000
200000000
20000000

Tamarin

Comment

10000

500

1000

300

2

Land
Cell990m.shp

bau

restore
EBI 5 per LV
Select by query
[Bioreg ID] <> 1
Environmental Benefits
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